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About This Guide
Introduction
This guide provides information about using the MC31XX mobile computers and accessories.

Documentation Set

The documentation set for the MC31XX is divided into guides that provide information for specific user needs.

• MC31XX Series Quick Start Guide - describes how to use the MC31XXS andMC31XXR mobile computers.

• MC3190G Quick Start Guide - describes how to use the MC3190G mobile computer.

• MC31XX Series Mobile Computer User Guide - describes how to use the MC31XX mobile computer.

• MC31XX Series Mobile Computer Integrator Guide - describes how to set up the MC31XX mobile 
computer and the accessories.

• Microsoft Applications for Windows Mobile 6.1 and CE 6.0 User Guide - describes how to use Microsoft 
developed applications.

• Application Guide for Motorola Enterprise Mobility Devices - describes how to use Motorola Enterprise 
Mobility developed applications.

• EMDK Help File - provides API information for writing applications.

NOTE Screens and windows pictured in this guide are samples and may differ from actual screens.

For configurations with OEM version 02.27.000X and Windows Mobile 6.5 operating system, refer to 
Appendix C, Windows Mobile 6.5 for information about new features.
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Configurations
This guide covers the following configurations:

Software Versions

This guide covers various software configurations and references are made to operating system or software 
versions for:

• Adaptation Kit Update (AKU) version

• OEM version

• BTExplorer version

• Fusion version.

AKU Version for Windows Mobile 6.X Devices

To determine the Adaptation Kit Update (AKU) version on a Windows Mobile 6.X device:

Tap Start > Settings > System tab > About icon > Version tab.

Configuration Radios Display Memory Data 
Capture

Operating
System Keypads

MC3100R WPAN: Bluetooth Color 128 MB RAM/
256 MB Flash 
or 256 MB 
RAM/512 MB 
Flash

1D laser 
scanner in 
rotating 
turret

Windows 
CE 6.0 
Professional

28, 38 or 48 
key

MC3100S WPAN: Bluetooth Color 128 MB RAM/
256 MB Flash 
or 256 MB 
RAM/512 MB 
Flash

1D laser 
scanner, 2D 
imager

Windows 
CE 6.0 
Professional or 
Windows 
Mobile 6.X 
Classic

28, 38 or 48 
key 

MC3190G WLAN: 802.11a/b/g
WPAN: Bluetooth

Color 128 MB RAM/
512 MB Flash 
or 256 MB 
RAM/1 GB 
Flash

1D laser 
scanner or 
2D imager

Windows 
CE 6.0 
Professional or 
Windows 
Mobile 6.X 
Classic

28, 38 or 48 
key

MC3190R WLAN: 802.11a/b/g
WPAN: Bluetooth

Color 128 MB RAM/
512 MB Flash 
or 256 MB 
RAM/1 GB 
Flash

1D laser 
scanner in 
rotating 
turret

Windows 
CE 6.0 
Professional or 
Windows 
Mobile 6.X 
Classic

28, 38 or 48 
key 

MC3190S WLAN: 802.11a/b/g
WPAN: Bluetooth

Color 128 MB RAM/
512 MB Flash 
or 256 MB 
RAM/1 GB 
Flash

1D laser 
scanner, 2D 
imager or 
DPM imager

Windows 
CE 6.0 
Professional or 
Windows 
Mobile 6.X 
Classic

28, 38 or 48 
key 
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The second line lists the operating system version and the build number. The last part of the build number 
represents the AKU number. For example, Build 20963.1.5.2 indicates that the device is running AKU version 
1.5.2.

OEM Version on Windows Mobile 6.X Devices

To determine the OEM software version on a Windows Mobile 6.X device:

Tap Start > Settings > System tab > System Information icon > System tab.

OEM Version on Windows CE 6.0 Devices

To determine the OEM software version on a Windows CE 6.0 device:

Tap Start > Settings > Control Panel > System Info icon > System tab.

BTExplorer Software

To determine the BTExplorer software version on a Windows Mobile 6.X or Windows CE 6.0 device:

Tap BTExplorer icon > Show BTExplorer> File > About.
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Fusion Software

To determine the Fusion software version on a Windows Mobile 6.X or Windows CE 6.0 device:

Tap Wireless Strength icon > Wireless Status > Versions.

Chapter Descriptions
Topics covered in this guide are as follows:

• Chapter 1, Getting Started, describes the mobile computer’s physical characteristics, how to install and 
charge the batteries, remove and replace the handstrap and how to start the mobile computer for the first 
time.

• Chapter 2, Operating the MC31XX, provides basic instructions for using the mobile computer and navigating 
the mobile computer software.

• Chapter 3, Using Bluetooth, explains how to perform Bluetooth functionality on the mobile computer.

• Chapter 4, Accessories, describes the accessories available for the mobile computer and how to use the 
accessories to charge the mobile computer.

• Chapter 5, Maintenance and Troubleshooting, includes instructions on cleaning and storing the mobile 
computer, and provides troubleshooting solutions for potential problems during mobile computer operation.

• Appendix A, Technical Specifications, includes a table listing the technical specifications for the mobile 
computer.

• Appendix B, Keypads, contains keypad descriptions and special character generation tables.

• Appendix C, Windows Mobile 6.5, explains the new features in Windows 6.5.3.
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Notational Conventions
The following conventions are used in this document:

• The term “mobile computer” refers to the Motorola MC31XX.

• Italics are used to highlight the following:

• Chapters and sections in this and related documents

• Dialog box, window and screen names

• Drop-down list and list box names

• Check box and radio button names

• Icons on a screen.

• Bold text is used to highlight the following:

• Key names on a keypad

• Button names on a screen.

• Bullets (•) indicate:

• Action items

• Lists of alternatives

• Lists of required steps that are not necessarily sequential.

• Sequential lists (e.g., those that describe step-by-step procedures) appear as numbered lists.
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Related Documents and Software
The following items provide more information about the MC31XX mobile computers.

• MC31XX Series Quick Start Guide, p/n 72-124259-xx

• MC3190G Quick Start Guide, p/n 72-124276-xx

• MC31XX Regulatory Guide, p/n 72-124293-xx

• MC31XX Series Mobile Computer Integrator Guide, p/n 72E-68900-xx

• Application Guide for Motorola Enterprise Mobility Devices, p/n 72E-68901-xx

• Microsoft® Applications for Mobile 6.1 and CE 6.0 User Guide, p/n 72E-108299-xx

• Enterprise Mobility Developer Kit (EMDK) Help File, p/n 72E-38880-03

• Windows CE Platform SDK for MC3100c50, available at: http://www.motorola.com/enterprisemobility/support

• Enterprise Mobility Developer Kit for C (EMDK for C), available at: 
http://www.motorola.com/enterprisemobility/support

• ActiveSync software, available at: http://www.microsoft.com.

For the latest version of this guide and all guides, go to: http://www.motorola.com/enterprisemobility/manuals.

Service Information
If you have a problem with your equipment, contact Motorola Enterprise Mobility support for your region. Contact 
information is available at: http://www.motorola.com/enterprisemobility/contactsupport.

When contacting Enterprise Mobility support, please have the following information available:

• Serial number of the unit

• Model number or product name

• Software type and version number

Motorola responds to calls by email, telephone or fax within the time limits set forth in support agreements.

If your problem cannot be solved by Motorola Enterprise Mobility Support, you may need to return your equipment 
for servicing and will be given specific directions. Motorola is not responsible for any damages incurred during 
shipment if the approved shipping container is not used. Shipping the units improperly can possibly void the 
warranty.

If you purchased your Enterprise Mobility business product from a Motorola business partner, contact that business 
partner for support.

http://www.motorola.com/enterprisemobility/support
http://www.motorola.com/enterprisemobility/support
http://www.motorola.com/enterprisemobility/support
http://www.microsoft.com
http://www.motorola.com/enterprisemobility/support
http://www.motorola.com/enterprisemobility/contactsupport


Chapter 1 Getting Started
Introduction
This chapter describes the mobile computer physical characteristics, how to install and charge the batteries, how to 
remove and replace the handstrap and how to start the mobile computer for the first time.

Unpacking the Mobile Computer
Carefully remove all protective material from around the mobile computer and save the shipping container for later 
storage and shipping. Verify that the equipment listed below is included:

• Mobile computer

• Battery

• Regulatory Guide

• Quick Start Guide.

Inspect the equipment for damage. If any equipment is missing or damaged, contact the Motorola Enterprise 
Mobility Support immediately. See Service Information on page xvi for contact information.

Features
There are three versions of the MC31XX mobile computers, the MC31XXS with 1D laser and 2D Imager, the 
MC31XXR with Rotating Scan Turret and the MC3190G with 1D laser and 2D Imager. For more information on the 
Rotating Scan Turret, see Figure 1-3 on page 1-3.
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Figure 1-1    MC31XXS and MC31XXR Mobile Computers (Front View)
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Figure 1-2    MC31XXS and MC31XXR Mobile Computers (Back View)

Rotating Scan Turret

The MC31XXR mobile computer features a Rotating Scan Turret with three position stops. This feature offers 
greater scanning flexibility. 

Figure 1-3    Rotating Scan Turret
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Handstrap

CAUTION Do not try to rotate turret past side position stops. Damage to device can occur.

Position Stop

Position Stop

Position Stop
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Figure 1-4    MC3190G Mobile Computer (Front View)
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Figure 1-5    MC3190G Mobile Computer (Back View)

Mobile Computer Startup
To start using the mobile computer:

• Install the SD card.

• Install the main battery. 

• Charge the main battery and the backup battery.

• Start the mobile computer.

Install SD Card

The Secure Device (SD) card provides secondary non-volatile storage (the flash memory is slower than RAM). The 
SD card holder is located under the battery.

Speakers

Trigger

Scan LED
Indicator

(red/green)

Headset Jack

Stylus Silo

CAUTION Follow proper Electro-Static Discharge (ESD) precautions to avoid damaging the SD card. Proper ESD 
precautions include, but are not limited to, working on an ESD mat and ensuring that the operator is 
properly grounded.

Do not use the SD card slot for any other accessories.
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To insert the SD card:

1. Lift the SD card retaining door.

2. Position the SD card, with the contacts down, into the SD card slot. The SD card corner notch fits into the slot 
only one way.

3. Close SD card retaining door.

Figure 1-6    Inserting the SD Card

Install Main Battery

If the main battery is charged, the mobile computer can be used immediately. If the main battery is not charged, 
see Battery Charging on page 1-8. To remove the main battery, see Main Battery Removal on page 1-11.

To install the main battery:

1. Remove the battery door.

2. Insert the battery into the slot, bottom first and press the battery gently into the slot. The battery clip locks the 
battery into place.

NOTE Select SD cards with environmental and/or the write cycle performance specifications that meet or exceed the 
application requirements.

SD Card Retaining Door SD Card
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Figure 1-7    Insert Battery

3. With the latches in the open position, replace the battery door, top first and press to close.

Figure 1-8    Insert Battery Door

4. Rotate the latches (to the lock position) to lock the door in place.

Figure 1-9    Close Latches

Battery

Door 

Latches
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Battery Charging 

Use the mobile computer cradles, cables and spare battery chargers to charge the mobile computer main battery.

The main battery can be charged before insertion into the mobile computer or after it is installed. There are two 
main batteries for the MC31XX, the Standard Battery (1X) and the Extended Life Battery (2X). The standard 
capacity battery ships from the factory in all MC31X0-R configurations. The Extended Life Battery ships from the 
factory in all MC31X0-S and MC31X0-G configurations. To install an Extended Life Battery in the MC31X0-R 
configurations, purchase an Extended Life Battery and a Brick Extended Life Battery door. Use one of the spare 
battery chargers to charge the main battery (out of the mobile computer) or one of the cradles to charge the main 
battery while it is installed in the mobile computer.

Before using the mobile computer for the first time, fully charge the main battery until the amber Charge LED 
Indicator remains lit (see Table 1-1 on page 1-9 for charge status indications). The Standard Battery fully charges in 
less than five hours and the Extended Life Battery fully charges in less than eight hours.

The mobile computer is equipped with a memory backup battery which automatically charges from the main 
battery whether or not the mobile computer is operating or is in suspend mode. The memory backup battery retains 
data in memory for at least 30 minutes when the mobile computer’s main battery is removed or fully discharged. 
When the mobile computer is used for the first time or after the memory backup battery has fully discharged, the 
memory backup battery requires approximately 15 hours to fully charge. Do not remove the main battery from the 
mobile computer for 15 hours to ensure that the memory backup battery fully charges. If the main battery is 
removed from the mobile computer or the main battery is fully discharged, the memory backup battery completely 
discharges in several hours.

When the main battery reaches a very low battery state, the combination of main battery and backup battery 
retains data in memory for at least 72 hours.

Batteries must be charged within the 0° to +40° C (32° to 104° F) ambient temperature range.

The following accessories can be used to charge batteries:

• Cradles (and a power supply): 

• Single Slot Serial/USB Cradle

• Four Slot Cradles.

• Cables (and a power supply): 

• USB Client Charge Cable

• Serial (RS232) Charge Cable.

• Spare Battery Chargers (and a power supply): 

• Single Slot Serial/USB Cradle

• Four Slot Spare Battery Charger 

• Universal Battery Charger (UBC) Adapter.

To charge the mobile computer using the cradles:

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-2.

NOTE Do not remove the main battery within the first 15 hours of use. If the main battery is removed before the 
backup battery is fully charged, data may be lost.
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1. Insert the mobile computer into a cradle. See Chapter 4, Accessories for accessory setup.

2. The mobile computer starts to charge automatically. The amber Charge LED Indicator indicates the charge 
status. See Table 1-1 on page 1-9 for charging indications.

To charge the mobile computer using the cables:

1. Connect the MC31XX Communication/Charge Cable to the appropriate power source and connect to the 
mobile computer. See Chapter 4, Accessories for accessory setup.

2. The mobile computer starts to charge automatically. The amber Charge LED Indicator indicates the charge 
status. See Table 1-1 for charging indications.

Spare Battery Charging
There are three accessories that can be used to charge a spare battery: 

• Single Slot Serial/USB Cradle

• Four Slot Spare Battery Charger

• UBC Adapter.

To charge a spare battery:

1. Connect the charging accessory to the appropriate power source. See Chapter 4, Accessories for setup 
instructions.

2. Insert the spare battery into the spare battery charging slot and gently press down on the battery to ensure 
proper contact.

The battery starts to charge automatically. The amber charge LED Indicator lights to indicate the charge status. 
See Chapter 4, Accessories for charging indications. The Standard Battery usually fully charges in less than five 
hours and the Extended Life Battery usually fully charges in less than eight hours.

Stylus
Use the stylus for selecting items and entering information on the screen. The stylus functions as a pen and a 
mouse. Tap the touch screen once with the stylus to select options and open menu items.

Table 1-1    Mobile Computer LED Charge Indicators  

LED Indication

Off Mobile computer not placed correctly in the cradle; charge cable not connected correctly; 
charger is not powered.

Fast Blinking Amber Error in charging; check placement of the mobile computer.

Slow Blinking Amber Mobile computer is charging.

Solid Amber Charging complete.
Note: When the battery is initially inserted in the mobile computer, the amber LED 
flashes once if the battery power is low or the battery is not fully inserted.
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To remove the stylus, slide the stylus out of the stylus holder. To store the stylus, push the stylus back into the 
stylus holder in the handstrap (MC31XXR/S) or stylus silo (MC3190G). 

Starting the Mobile Computer
Press the Power button to turn on the mobile computer. If the mobile computer does not power on, perform a cold 
boot. See Resetting the Mobile Computer on page 2-23.

When the mobile computer is powered on for the first time, it initializes. The Splash screen appears for a short 
period of time, followed by the Calibration screen.

 

Figure 1-10    Splash Screen

On Windows CE 6.0 configurations, after the calibration procedure is performed the factory settings launch the 
Sample Applications window displays. Application specific shells may provide application specific windows 
instead of the Sample Applications window. These screens also appear when a cold boot is performed.

If the mobile computer does not power on, see Resetting the Mobile Computer on page 2-23.

Calibration Screen

Use the Calibration screen to align the touch screen:

1. Remove the stylus from the stylus holder.

2. Carefully press and briefly hold the stylus tip on the center of the Calibration screen target. Repeat the 
procedure as the target moves and stops at different locations on the screen. This enters the new calibration 
settings.

 

Figure 1-11    Calibration Screen

3. Once all of the new calibration settings are input, tap the screen or press the ENTER button to save the new 
calibration settings. Press ESC to discard the new calibration settings.
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Waking the Mobile Computer
The wakeup condition settings are used to define what actions wake up the mobile computer. The settings are 
configurable so they are subject to change/update. For more information see, Waking the Mobile Computer on 
page 2-24.

Main Battery Removal
To remove the main battery from an MC31XXS/R:

1. If the MC31XXS/R is in suspend mode, press the Power button to wake the device.

2. Press the power button to place the MC31XXS/R in suspend mode.

3. Wait for the red Scan LED to turn on and then turn off.

4. Rotate the latches to the open position.

Figure 1-12    Open Latches

5. Lift the door off, bottom first.

Figure 1-13    Lift Battery Door

NOTE On devices with Windows Mobile 6.5.3, a dialog box appears when pressing the Power button. See Removing 
the Battery on page C-13 for more information.

CAUTION Do not lift up on the latches when removing the door. Lift up on the handstrap only.

Latches
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6. With finger, press the battery clip in (at the top of the battery) and lift the battery out top first.

Figure 1-14    Remove Battery

To remove the main battery from an MC3190G:

1. If the MC3190G is in suspend mode, press the Power button to wake the device.

2. Press the Power button to place the MC3190G in suspend mode.

3. Wait for the red Scan LED to turn on and then turn off.

4. Rotate the latches to the open position.

Figure 1-15    Open Latches

5. Lift the door off, bottom first.

WARNING! Do not use a tool to remove the battery.

Battery Clip

NOTE On devices with Windows Mobile 6.5.3, a dialog box appears when pressing the Power button. See Removing 
the Battery on page C-13 for more information.

CAUTION Do not lift up on the latches when removing the door. Lift up on the handstrap only.
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Figure 1-16    Lift Door

6. With two finger, press the battery toward the bottom of the mobile computer and lift the battery out top first.

Figure 1-17    Press the Battery Toward Bottom of MC3190G

Handstrap Removal and Replacement (MC31XXS/R)
To remove the handstrap:

1. Use a #00 Phillips screwdriver to remove the screws.

2. Lift the mounting clip.

3. Slide the mounting clip out of the strap loop.

4. Open the handstrap flap and pull the handstrap through the battery door mounting slot.

WARNING! Do not use a tool to remove the battery.
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Figure 1-18    Strap/Door Removal and Replacement (MC31XXS/R)

To replace the handstrap:

1. Feed the mounting clip through the strap loop.

2. Secure the mounting clip to the housing using the two screws.

3. Feed the handstrap through the slot on the battery door.

4. Attach the hook material to the loop material and press together.

Handstrap Removal and Replacement (MC3190G)
To remove the handstrap:

1. Slip the button through the loop.

Figure 1-19    Remove Button from Loop

2. Remove loop section from handle.

3. Separate the loop and hook tape and pull the handstrap through the slot in the battery door.

Screws

#00 Phillips
Screwdriver

Mounting 
ClipStrap Loop

Mounting 
Clip

Button

Loop
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Figure 1-20    Remove Handstrap from Battery Door Slot

To install a new handstrap:

1. Insert one end of the loop section into the mounting slot in the handle.

2. Thread the other end of the loop section through the loop and pull to tighten the loop.

Figure 1-21    Thread Loop

3. Slip the button into the loop section.

Figure 1-22    Slip Button Through Loop

4. Thread the end of the handstrap into the slot in the battery door.

Button

Loop
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Figure 1-23    Thread Handstrap into Battery Door Slot

5. Press the hook material against the loop material.
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Turning Off the Radios

On Device with Windows CE 6.0

WLAN Radio

To turn off the WLAN radio tap the Fusion Signal Strength icon on the task tray and select Disable Radio. A red 
X appears across the icon indicating that the radio is disabled (off).

Figure 1-24    Fusion Signal Strength Icon

To turn the radio back on, tap the Fusion Signal Strength icon on the task tray and select Enable Radio. The red 
X disappears from the icon indicating that the radio is enabled (on).

Bluetooth Radio with StoneStreet One Stack Enabled

To turn off the Bluetooth radio, tap the Bluetooth icon in the task tray and select Disable Bluetooth.

Figure 1-25    Bluetooth Icon

To turn on the Bluetooth radio, tap the Bluetooth icon in the task tray and select Enable Bluetooth.

On Devices with Windows Mobile 6.X

Windows Mobile 6.1 devices include Wireless Manager, which provides a simple method of enabling, disabling, 
and configuring all the device’s wireless capabilities in one place.

To open Wireless Manager, tap the Connectivity icon.

Figure 1-26    Opening Wireless Manager

Select Wireless Manager.

Fusion Signal Strength Icon

Bluetooth Icon
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Figure 1-27    Wireless Manager Window

To enable or disable a wireless connection, tap its blue bar.

To enable or disable all wireless connections, tap and hold the All bar.

To configure settings for a connection, tap Menu.

Figure 1-28    Wireless Manager Menu



Chapter 2 Operating the MC31XX
Introduction
This chapter provides basic instructions for using the mobile computer and navigating the mobile computer 
software.

Power Button
Press the red Power button to toggle the mobile computer between suspend and resume. When the screen is off 
the mobile computer is in suspend mode and when the screen is on the mobile computer is on.

Windows CE Sample Applications Window
The MC31XX with Windows CE contains a set of sample applications that can be installed. By default an 
installation icon is on the Desktop. Double-tap the icon to install the sample applications. When installed, the 
Sample Applications window appears on the screen whenever the MC31XX re-boots. Refer to the MC31XX 
Series Mobile Computer Integrator Guide for installation and configuration.

The Sample Applications window links to sample applications. The sample applications are intended to be used 
by application developers as application development examples. These applications were not developed to 
support end users. Refer to the Application Guide for Motorola Enterprise Mobility Devices for the sample 
applications.

Figure 2-1    Sample Applications Window
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Windows CE Desktop
The desktop displays the applications available with the Windows CE configurations. For information on using the 
Microsoft® applications refer to the Microsoft® Applications for Mobile and CE 6.0 User Guide, p/n 72E-78456-xx.

Figure 2-2    Windows CE Desktop

Windows CE Status Icons
The taskbar (at the bottom of the screen) displays the Start button, active programs, battery status and 
communication status. The taskbar icons are described in Table 2-1. The taskbar icons display the function status, 
indicate what programs are active and indicate the battery charge status. The Taskbar buttons are used to access 
menus, select/deselect functions or to change display windows.

• Status Icons: The status icons indicate the function key status. If the FUNC, SHIFT, CTRL, ALT or ALPHA 
functions are active the appropriate status icon is displayed. 

• Active Programs Icons: The active applications icons are displayed on the taskbar. If more than one program 
is active, icons can be used to toggle between the open programs (applications). Tap on a taskbar application 
to maximize the application. 

• AC Power/Battery Status Icons: The AC Power/Battery Status icons are shown in the taskbar to indicate the 
present power supply status of the mobile computer. The main battery status icons provide the battery status 
in 10% increments from 10% to 100%. The backup battery low icon indicates that the backup battery charge 
is low. See Battery Charging on page 1-8 for backup battery charging instructions.
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Figure 2-3    Taskbar

Table 2-1    Taskbar Icons

Icon Description

Indicates that the battery is charging.

Indicates that the battery is fully charged (100% charged).
The battery status icons provide the battery status in 10% increments from 10% to 100%.

Indicates that communication with the smart battery has not been established. After a mobile computer 
reset, this icon may be displayed for up to 30 seconds. See, Battery Unknown Icon on page 2-4 for 
additional information.

Indicates that the backup battery is low.

Indicates that the battery is fully charged and the mobile computer is running on external power.

Indicates IP status. Only displays when the mobile computer is in emulation mode.

Indicates that the ActiveSync application is running.

Indicates that the wireless application radio is connected to a wireless LAN network with excellent signal 
strength.

Indicates that the wireless application radio is not connected to a wireless LAN network. 

The Bluetooth Enabled icon appears in the task tray and indicates that the Bluetooth radio is on (Displays 
only if the StoneStreet One Bluetooth stack is enabled).

The Bluetooth Disabled icon appears in the task tray and indicates that the Bluetooth radio is off 
(Displays only if the StoneStreet One Bluetooth stack is enabled).

The Bluetooth Communication icon appears in the task tray and indicates that the mobile computer is 
communicating with another Bluetooth device (Displays only if the StoneStreet One Bluetooth stack is 
enabled).

Opens the IST control panel.

Indicates that the SHIFT button function is selected.

Start Button

Open Programs and Status Icons

Keyboard Input Panel Button

Desktop Display Button

Window Title Scroll Status Icons
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Battery Unknown Icon

The Battery Unknown icon displays when communication with the smart battery has not been established. As part 
of normal operation this icon may be displayed for 30 seconds following a mobile computer reset.

If the icon displays beyond this 30 second period:

1. Remove and re-seat the battery.

2. If after re-seating the battery, the icon remains, warm boot the mobile computer.

3. If after warm booting the mobile computer, the icon remains, then cold boot the mobile computer.

4. If after cold booting the mobile computer, the icon remains, install a new (tested and working) battery.

5. If the icon remains, return the mobile computer for servicing.

Start Button

Tap the Start button to launch the Start menu.

• Programs: Use to access available programs.

• Favorites: Displays files in Favorites directory.

• Documents: Displays files in Documents directory.

• Settings: Accesses the Control Panel, the Network and Dial-up Connections and the Taskbar and Start 
menu.

• Help: Accesses the Windows CE Help.

• Run: Runs a program or application.

• Suspend: Places the mobile computer in the suspend state.

Programs Menu

From the Start menu, tap Programs to open the Programs menu. The programs installed on the MC31XX with 
Windows CE display in the Programs menu. Refer to the Application Guide for Motorola Enterprise Mobility 
Devices, p/n 72-68901-xx and the Microsoft® Applications for Mobile 6.1 and CE 6.0 User Guide, p/n 
72E-108299-xx for application information.

Indicates that the FUNC button function is selected.

Indicates that the CTRL button function is selected.

Indicates that the ALT character selection is selected.

Indicates that the mobile computer is in ALPHA button mode is selected.

Table 2-1    Taskbar Icons (Continued)

Icon Description

ALT
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Keyboard Input Panel Button

Use the Keyboard Input Panel as an alternate input device. For more information, see Entering Information Using 
the Keyboard Input Panel on page 2-15.

Desktop Display Button

Use the Desktop Display button to minimize all open programs and display the desktop.

• My Computer: Double-tap the icon to open My Computer.

• Recycle Bin: Deleted files remain in the recycle bin until the recycle bin is emptied. Once emptied the files 
cannot be retrieved.

• Remote Desktop Connection: Tap the Remote Desktop Connection icon to access the Remote Desktop 
Connection window.

Task Manager and Properties
Use the Task Manager to control an application’s use and use the Properties functions to set display and clock 
options.

Task Manager

1. Select FUNC - CTRL, (to activate the ALT state) and tap on the taskbar to display the Task Manager, 
Properties Selection menu.

2. Tap Task Manager to display the Task Manager window.

Figure 2-4    Task Manager Window

3. Tap a task in the Active Tasks list and tap Switch To to make that task the primary task, or tap End Task to 
end the selected task.

4. Tap X to exit the Task Manager window.

Properties

1. Tap Start > Control Panel > Taskbar and Start Menu ... . The Task Manager, Properties window displays, 
see Figure 2-6 on page 2-6.

2. Tap Properties to display the Taskbar and Start Menu, General tab.

3. This menu provides taskbar options:

• Check the Always on Top checkbox to keep the taskbar on top of all other windows.
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• Check the AutoHide checkbox to make the taskbar disappear, touch the bottom of the display to make the 
taskbar return.

• Check the Show Clock checkbox to display the clock on the taskbar.

4. Tap OK to save the settings and exit the window.

Figure 2-5    Taskbar and Start Menu, General Tab

Advanced Tab

1. Tap the Advanced tab to enter the Taskbar and Start Menu, Advanced tab.

2. Tap the Clear button to delete all of the documents listed in the Start > Documents entry, see Start Button on 
page 2-4. Typically this list is empty, but if there were documents in the list the Clear button would delete them.

3. Tap the Expand Control Panel checkbox to display the entire contents of the MS control panel in list form, 
rather than icons.

Figure 2-6    Taskbar and Start Menu, Advanced Tab

4. Tap OK to save the settings and exit the window.

Windows Mobile 6.1 Today Screen

The Today screen displays important information, such as upcoming appointments and status indicators. Tap a 
section on the screen to open the associated program. Alternatively, tap Start > Today to display the Today 
screen.

NOTE On devices with Windows Mobile 6.5.3, the Today screen is different. See Home Screen on page C-1 for more 
information.
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Figure 2-7    Today Screen

To customize the Today screen, tap Start > Settings > Today icon. Use the Appearance tab to customize the 
background and the Items tab to change the list and order of items that appear on the screen.

Windows Mobile 6.1 Status Icons

Status Bar

Status icons are shown in the Status Bar to indicate present status of the mobile computer. Tapping each status 
icon displays the corresponding dialog box and enables you to change or adjust its settings. You may see the 
status icons listed in Table 2-2 on the Status Bar located at the top of the screen.

Open the Start Menu Adjust volume

Change the date and time

Soft Keys

Battery Status

Command Bar

Turn on or off radios

Fusion Signal Strength

IST

Notification
Connectivity

NOTE On devices with Windows Mobile 6.5.3, see Status Bar on page C-4 for more information.

Table 2-2    Status Icons

Icon Function Description

 Audio Speaker is on.

Speaker is off.

 Battery Backup battery is very low.

 Main battery is charging.*

Main battery level.*

 Main battery is very low.*

* Only appears in the Time and Next Appointment dialog box.
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Command Bar

You may see the icons listed in Table 2-3 on the Command Bar located at the bottom of the screen.

Figure 2-8    Command Bar

 Connectivity Connection is active.

ActiveSync error

 Synchronization is occurring.

 Instant Message Notification that one or more instant messages were received.

 E-Mail Notification that one or more e-mail messages were received.

Time and Next 
Appointment

Displays current time in analog or digital format.

 Multiple Notifications There are more notification icons than can be displayed. Tap to display 
remaining icons.

Table 2-2    Status Icons (Continued)

Icon Function Description

* Only appears in the Time and Next Appointment dialog box.

Table 2-3    Command Bar Icons

Icon Description

Wireless connection status icon. Indicates WLAN signal strength and opens the Wireless 
Applications menu.

The Bluetooth Enabled icon appears in the task tray and indicates that the Bluetooth radio is on 
(Displays only if the StoneStreet One Bluetooth stack is enabled).

The Bluetooth Disabled icon appears in the task tray and indicates that the Bluetooth radio is off 
(Displays only if the StoneStreet One Bluetooth stack is enabled).

Status Icons
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Speaker Icon

You can adjust the system volume using the Speaker icon in the Status bar.

1. Tap the Speaker icon. The Volume dialog box appears.

Figure 2-9    Volume Dialog Box

2. Tap and move the slide bar to adjust the volume.

3. Select the On or Off radio button to turn the volume on or off.

Battery Icons

The Main Battery icon appears in the Title Bar when the Today screen is visible. The icon indicates the battery 
power level.

The Bluetooth Communication icon appears in the task tray and indicates that the mobile 
computer is communicating with another Bluetooth device (Displays only if the StoneStreet One 
Bluetooth stack is enabled).

Opens the IST control panel.

The ActiveSync icon appears in the task tray and indicates an active serial connection between the 
mobile computer and the development computer.

Table 2-3    Command Bar Icons (Continued)

Icon Description

NOTE Use can also adjust the system volume using the Sounds & Notifications window or by using the keypad. 
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Figure 2-10    Battery Icon on the Title Bar

You can also view the battery status using the Power window.

When the main battery power falls below a predetermined level a Main Battery dialog box appears indicating the 
status of the main battery. When the backup battery power falls below a predetermined level a Backup Battery 
icon and dialog box appears indicating the status of the backup battery.

Figure 2-11    Battery Status Icons and Dialog Boxes

Connectivity Icon

The Connectivity icon indicates the communication status of the terminal when it’s connecting to the internet or 
host computer.

Figure 2-12    Connectivity Dialog Box

Time Icon

The Time icon displays the current time in a digital or analog format. To change the time format, tap and hold the 
Time icon until a menu appears. Select the format you want.

NOTE The Time icon only appears in the Title Bar when an application displays. It does not appear it the Title 
Bar when the Today screen displays.
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Figure 2-13    Time Icon Format Menu

To display current date, time and appointments:

1. Tap the Time icon to display the Time and Next Appointment dialog box.

Figure 2-14    Time and Next Appointment Dialog Box

2. The dialog box displays the current date and time, the battery status and any upcoming appointments in the 
Calendar.

E-Mail Icon

The E-Mail icon notifies you when you have received incoming e-mails.

Figure 2-15    New E-mail Messages Dialog Box

Multiple Notification Icon

The Multiple Notification icon appears when two or more message notifications occur. Tap the icon to display the 
multiple notification icons.

Analog ClockDigital Clock

Battery Status Icon
Upcoming Appointments

Current Date and Time
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Figure 2-16    Multiple Notifications Icon

Locking the Mobile Computer (Windows Mobile 6.1 Only)

You can lock the MC311XX by disabling key presses and screen tap or by requiring a password.

Keypad Locking

Locking the MC31XX turns off keyboard and touch screen functionality. This is helpful when the MC31XX is turned 
on and you want to prevent accidental key presses.

To lock the device, tap the Device unlocked icon. The icon changes to locked.

Figure 2-17    Device Locked/Unlocked Icons

To unlock the device and free it for use, tap Unlock.

Figure 2-18    Unlock Device Window

Tap Unlock on the Unlock window.

NOTE On devices with Windows Mobile 6.5.3, the locking feature is different. See Locking the MC3100 on page C-10 
for more information.

Device Unlocked Icon Device Locked Icon
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Password Locking

Use the Password window to set a password to disable unauthorized access to the MC31XX.

1. Tap Start > Settings > Personal tab > Lock icon > Password tab.

Figure 2-19    Password Window - Password Tab

2. Select Prompt if device unused for check box to enable password protection.

3. From the drop-down list, select a time value for the protection to take affect after non-use.

4. From the Password type: drop-down list, select either Simple PIN or Strong alphanumeric.

5. For a simple password, enter a four-digit password in the Password field.

For a stronger password:

a. Enter a seven character password in the Password: field. A strong password must contain at least seven 
characters and contain at least three of the following: uppercase and lowercase letters, numerals, and 
punctuation.

b. Re-enter the password in the Confirm: field.

6. Tap ok.

7. To set a hint to remember the password, tap the Hint tab.

Figure 2-20    Password Window - Hint Tab

8. In the text box, enter a hint for a password reminder.

9. Tap ok.

NOTE If the device is configured to connect to a network, use a strong (difficult to figure out) password 
to help protect network security. Password cracking tools continue to improve and the 
computers used to crack passwords are more powerful than ever.
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When the MC31XX is not used for a period of time and the user tries to access the device, the Password window 
appears.

Figure 2-21    Enter Password Windows

Enter the password to un-lock the device.

Tap Unlock.
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Entering Information
To enter information:

• Use the keypad.

• Use the keyboard input panel (soft keyboard) to enter text.

• Scan bar code data into data fields.

• Use Microsoft® ActiveSync® to synchronize or copy information from the host computer to the mobile 
computer. For more information on ActiveSync, refer to the MC31XX Series Mobile Computer Integrator 
Guide.

Entering Information Using Keypad

The 28, 38 and 48-key alphanumeric keypads produce the 26-character alphabet (A - Z), numbers (0 - 9), function 
keys and assorted characters. The keypads default characters/functions are printed black or white, the ALPHA 
character/functions are printed orange and the FUNC character/functions are printed blue. See Appendix B, 
Keypads for keypad configurations, keypad special functions and special character generation.

Entering Information Using the Keyboard Input Panel

Use the keyboard input panel (soft keyboard) to enter information in any program. To launch the keyboard input 
panel, tap the  button on the taskbar. Tap a key to enter the value. Tap the keyboard input panel button to 
display or to hide the keyboard input panel.

Figure 2-22    Keyboard Input Panel

Entering Data via the Bar Code Scanner

The sample bar code scanner application scans data into data fields in the same way data is entered via the 
keypad.

Windows CE 6.0 Windows Mobile 6.1
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Interactive Sensor Technology
This section describes the functionality of the Interactive Sensor Technology (IST) feature on the MC31XX.

The IST supports the following features.

• Power Management – manage power by configuring IST to control switching on/off the backlight, control 
suspend mode of the MC31XX by monitoring motion and orientation.

• Display Orientation – switch the screen orientation to either landscape or portrait depending on the MC31XX 
orientation.

• Free Fall Detection – monitors free fall duration and records the time and type of the drop event.

Power Management

The MC31XX orientation and motion sensitive data can be used as an indicator of MC31XX usage and can be 
used to manage the battery power of the mobile computer. For example, IST can be configured to control the 
backlight on and off functionality or go into suspend according to a user gesture by placing screen facing down. It 
can also be used to keep the MC31XX active while it is in movement to prevent it from quickly going into suspend 
mode while in use.

Display Orientation

The screen can be rotated between portrait and landscape modes automatically, depending on the physical 
orientation of the MC31XX. For example, if the MC31XX is rotated 90° counterclockwise, IST rotates the display 
counterclockwise 90° so that the screen display appears correct.

This functionality is achieved by monitoring screen angle and rotating the display to counter any changes. IST only 
rotates the screen in multiples of 90°.

Figure 2-23    Display Orientation
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Free Fall Detection

IST continuously monitors gravitational force on the MC31XX according to its current position. When the MC31XX 
free falls, IST detects the absence of gravitational force and records the event data if it detects a free fall more than 
450 ms, which may indicate nearly a one meter drop. This data can be used as an indicator of potential abuse or 
misuse.

IST features a log for recording the free fall events. This log records the date, time and the time period of the free 
fall.

Figure 2-24    Free Fall Detection
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Connecting a Wired headset
To connect a wired headset to the MC31XX:

Figure 2-25    Connect Headset to MC31XX
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Using a Bluetooth Headset
You can use a Bluetooth headset for audio communication when an audio enabled application is used. See 
Chapter 3, Using Bluetooth for information on connecting a Bluetooth device to the mobile computer. Ensure that 
the mobile computer’s volume is set appropriately before putting the headset on. When a Bluetooth headset is 
connected the speaker is muted.

Data Capture
The mobile computer has an integrated laser scanner or imager that collects data by scanning bar codes.

Laser Scanning

To scan bar codes with the mobile computer:

1. Ensure that the mobile computer is loaded with a scanning application. 

2. If the mobile computer is equipped with a rotating head, adjust the head prior to scanning.

3. Aim the scan window at the bar code.

4. Press the scan button or trigger. Ensure the red scan beam covers the entire bar code. The Scan LED 
Indicators illuminate red to indicate that the laser is on. The Scan LED Indicators illuminate green and a beep 
sounds to indicate a successful decode.

Figure 2-26    Laser Aiming

Optimal scanning distance varies with bar code density and scanner optics.

• Hold the scanner farther away for larger symbols.

• Move the scanner closer for symbols with bars that are close together.

Scan LED Indicators

The red/green Scan LED Indicators (located in the Indicator LED Bar and in the rotating turret) indicates the scan 
status. For the location of the Scan LED Indicators see, Figure 1-1 on page 1-2.

NOTE If the mobile computer goes into suspend mode the Bluetooth connection is disabled and the mobile 
computer automatically switches to speakerphone mode.

WrongRight

NOTE Scanning procedures depend on the application and mobile computer configuration. An application may use 
different scanning procedures from the one listed above.
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Scanning Considerations

Scanning consists of; aim, scan and decode. Scanning performance can be optimized by considering the range 
and the scanning angle:

• Range

Any scanning device decodes well over a particular working range (minimum and maximum distances from 
the bar code). This range varies according to bar code density and scanning device optics.

Scanning within range brings quick and constant decodes; scanning too close or too far away prevents 
decodes. Move the scanner closer and further away to find the right working range for the bar codes being 
scanned. However, the situation is complicated by the availability of various integrated scanning modules. 
The best way to specify the appropriate working range per bar code density is through a chart called a 
decode zone for each scan module. A decode zone simply plots working range as a function of minimum 
element widths of bar code symbols.

• Angle

The scan angle is important for optimizing decode performance. When laser beams reflect directly back into 
the scanner from the bar code, this specular reflection can “blind” the scanner.

To avoid this, scan the bar code so that the beam does not bounce directly back. But do not scan at too sharp 
an angle; the scanner needs to collect scattered reflections from the scan to make a successful decode. 
Practice quickly shows what tolerances to work within.

Imaging
MC31XX with an integrated imager have the following features:

• Omnidirectional (360°) reading of a variety of bar code symbologies, including the most popular linear, postal, 
PDF417, and 2D matrix code types.

• The ability to capture and download images to a host for a variety of imaging applications.

• Advanced intuitive laser aiming for easy point-and-shoot operation.

The imager uses digital camera technology to take a digital picture of a bar code, stores the resulting image in its 
memory, and executes state-of-the-art software decoding algorithms to extract the data from the image.

Table 2-4    Scan LED Indicators

LED Status Indication

Off Not scanning.

Solid Red Laser enabled, scanning in process.

Solid Green Successful decode.

NOTE Contact the Motorola Enterprise Mobility Support Center if chronic scanning difficulties develop. Decoding of 
properly printed bar codes should be quick and effortless.
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Operational Modes

MC31XX with an integrated imager support three modes of operation, listed below. Activate each mode pressing 
the Scan button.

• Decode Mode: In this mode, the MC31XX attempts to locate and decode enabled bar codes within its field of 
view. The imager remains in this mode as long as you hold the scan button, or until it decodes a bar code.

• Pick List Mode: This mode allows you to selectively decode a bar code when more than one bar code is in 
the MC31XX’s field of view. To accomplish this, move the aiming crosshair center dot over the required bar 
code to decode only that bar code. This feature is ideal for pick lists containing multiple bar codes and 
manufacturing or transport labels containing more than one bar code type (either 1D or 2D).

• Image Capture Mode: Use this mode to capture an image within the MC31XX’s field of view. This is useful 
for capturing signatures or images of items like damaged boxes.

Imager Scanning

1. Ensure that a scan-enabled application is loaded on the MC31XX.

2. Aim the exit window at the bar code.

3. Press the scan button.

The red laser aiming pattern turns on to assist in aiming. Ensure the cross-hair is on top of the bar code.

The Scan LED lights red to indicate that scanning is in process, then lights green and a beep sounds, by 
default, to indicate the bar code was decoded successfully. Note that when the MC31XX is in Pick List Mode, 
the imager does not decode the bar code until the crosshair center dot touches the bar code.

Figure 2-27    Imager Aiming Pattern

NOTE To enable Pick List Mode, download the Control Panel applet from the Support Central web site at 
http://www.motorola.com/enterprisemobility/support. Pick List can also be set in an application using a API 
command.

http://www.motorola.com/enterprisemobility/support
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Figure 2-28    Pick List Mode with Multiple Bar Codes

4. Release the scan button.

NOTE Imager decoding usually occurs instantaneously. The MC31XX repeats the steps required to take a digital 
picture (image) of a poor or difficult bar code as long as the scan button remains pressed.
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Resetting the Mobile Computer

Windows CE 6.0 Devices

If the mobile computer stops responding to input, reset it. There are two reset functions, warm boot and cold boot. 
A warm boot restarts the mobile computer by closing all running programs. All data that is not saved is lost.

A cold boot also restarts the mobile computer, but erases all stored records and entries from RAM. In addition it 
returns formats, preferences and other settings to the factory default settings.

Perform a warm boot first. If the mobile computer still does not respond, perform a cold boot.

Performing a Warm Boot

To perform a warm boot:

1. Press the Power button for five seconds.

2. As the mobile computer initializes MC31XX Sample Applications window appears.

Performing a Cold Boot

A cold boot restarts the mobile computer and erases all user stored records and entries from RAM. Never perform 
a cold boot unless a warm boot does not solve the problem.

To perform a cold boot:

1. Simultaneously press and then release the 1, 9 and Power keys. Do not hold down any other keys or buttons. 
As the mobile computer initializes, the splash window, Figure 1-10 on page 1-10, appears for about a minute.

2. Calibrate the touch screen. See Calibration Screen on page 1-10 to calibrate the mobile computer screen.

Windows Mobile 6.1 Devices

There are two reset functions, warm boot and cold boot.

• A warm boot restarts the mobile computer and closes all running programs.

• A cold boot also restarts the mobile computer and closes all running programs but also resets the 
Real-Time-Clock (RTC).

Data saved in flash memory or a memory card is not lost. Perform a warm boot first. This restarts the mobile 
computer and saves all stored records and entries. If the mobile computer still does not respond, perform a cold 
boot.

Performing a Warm Boot

To perform a warm boot:

1. Press the Power button for five seconds.

CAUTION Files that remain open during a warm boot may not be retained.

CAUTION Cold boot resets the mobile computer, to the default settings. All added applications and all stored data are 
removed. Do not cold boot without support desk approval.
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2. As the mobile computer initializes Today screen appears.

Performing a Cold Boot

A cold boot restarts the mobile computer. The operating system and all applications are restarted. File storage is 
preserved and some drivers are initialized. Only perform a cold boot if a warm boot does not solve the problem.

1. To perform a cold boot, simultaneously press and then release the 1, 9 and Power keys. Do not hold down any 
other keys or buttons.

2. As the mobile computer initializes, the splash window, Figure 1-10 on page 1-10, appears.

Waking the Mobile Computer
The wakeup conditions define what actions wake up the mobile computer after it has gone into suspend mode. The 
mobile computer can go into suspend mode by either pressing the Power button or automatically by Control Panel 
time-out settings. These settings are configurable and the factory default settings are shown in Table 2-5. 

To access the Wakeup settings:

On Window CE 6.0 devices, tap Start > Settings > Control Panel > Power icon > Wakeup tab.

Table 2-5    Wakeup Default Settings

Condition for Wakeup Power Button Automatic Time-out

AC power is applied. No Yes

Mobile computer is inserted into a cradle. No Yes

Mobile computer is removed from a cradle. No Yes

Mobile computer is connected to a serial device. No Yes

Mobile computer is connected to a USB device. No Yes

Mobile computer is disconnected from a USB device. No Yes

A key is pressed. No Yes

The scan triggered is pressed. No Yes

The screen is touched. No No

Bluetooth Yes Yes

On Motion No Yes

USB Host No No

Wireless LAN activity is detected. No No
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Figure 2-29    Windows CE 6.0 Wakeup Tab

On Windows Mobile 6.1 devices, tap Start > Settings > System tab > Power icon > Wakeup tab.

Figure 2-30    Windows Mobile 6.1 Wakeup Tab
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Chapter 3 Using Bluetooth
Introduction
Bluetooth-equipped devices can communicate without wires, using frequency-hopping spread spectrum (FHSS) 
radio frequency (RF) to transmit and receive data in the 2.4 GHz Industry Scientific and Medical (ISM) band 
(802.15.1). Bluetooth wireless technology is specifically designed for short-range (30 feet/10 meters) 
communication and low power consumption. 

MC31XXs with Bluetooth capabilities can exchange information (e.g., files, appointments, and tasks) with other 
Bluetooth enabled devices such as phones, printers, access points, and other mobile computers. To use the 
MC31XX as a modem, create a dial-up modem connection between a computer and MC31XX.

TheMC31XX with Bluetooth technology uses either the StoneStreet Bluetooth stack or the Microsoft Bluetooth 
stack. To write an application that uses the StoneStreet One Bluetooth stack APIs, refer to the Enterprise Mobility 
Developer Kit (EMDK) Help.

Adaptive Frequency Hopping
Adaptive Frequency Hopping (AFH) is a method of avoiding fixed frequency interferers, and can be used with 
Bluetooth voice. All devices in the piconet (Bluetooth network) must be AFH-capable in order for AFH to work. 
There is no AFH when connecting and discovering devices. Avoid making Bluetooth connections and discoveries 
during critical 802.11b communications. AFH for Bluetooth consists of four main sections:

• Channel Classification - A method of detecting an interference on a channel-by-channel basis, or pre-defined 
channel mask.

• Link Management - Coordinates and distributes the AFH information to the rest of the Bluetooth network.

• Hop Sequence Modification - Avoids interference by selectively reducing the number of hopping channels.

• Channel Maintenance - A method for periodically re-evaluating the channels.

When AFH is enabled, the Bluetooth radio “hops around” (instead of through) the 802.11b high-rate channels. AFH 
coexistence allows Motorola mobile computers to operate in any infrastructure. 

The Bluetooth radio in this MC31XX operates as a Class 2 device power class. The maximum output power is 
2.5mW and the expected range is 32.8 feet (10 meters). A definition of ranges based on power class is difficult to 
obtain due to power and device differences, and whether one measures open space or closed office space.
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Security
The current Bluetooth specification defines security at the link level. Application-level security is not specified. This 
allows application developers to define security mechanisms tailored to their specific need. Link-level security 
occurs between devices, not users, while application-level security can be implemented on a per-user basis. The 
Bluetooth specification defines security algorithms and procedures needed to authenticate devices, and if needed, 
encrypt the data flowing on the link between the devices. Device authentication is a mandatory feature of Bluetooth 
while link encryption is optional.

Pairing of Bluetooth devices is accomplished by creating an initialization key that is used to authenticate the 
devices and create a link key for them. Entering a common PIN number in the devices being paired generates the 
initialization key. The PIN number is never sent over the air. By default, the Bluetooth stack responds with no key 
when a key is requested (it is up to user to respond to the key request event). Authentication of Bluetooth devices 
is based-upon a challenge-response transaction. Bluetooth allows for a PIN number or passkey that is used to 
create other 128-bit keys used for security and encryption. The encryption key is derived from the link key used to 
authenticate the pairing devices. Also worthy of note is the limited range and fast frequency hopping of the 
Bluetooth radios that makes long-distance eavesdropping difficult.

Recommendations are:

• Perform pairing in a secure environment

• Keep PIN codes private and don't store the PIN codes in the mobile computer

• Implement application-level security.

The Microsoft stack supports Smart-pairing. For detailed information, refer to the Microsoft MSDN.

Bluetooth Configuration
By default, the MC31XX is configured to using the Microsoft stack. Refer to the MC31XX Series Mobile COmputer 
Integrator Guide, for information on switching between the Microsoft Bluetooth stack and the StoneStreet One 
Bluetooth stack.

If the MC31XX is configured to use the StoneStreet One Bluetooth stack, the Bluetooth icon appears at the bottom 
right corner of the Today screen on Windows Mobile devices and in the Status bar for WinCE devices. If the 
Microsoft Bluetooth stack is configured, the Bluetooth icon does not appear.

Figure 3-1    Bluetooth Icon

Table 3-1 list the services supported by the StoneStreet One Bluetooth stack and the Microsoft Bluetooth stack.

NOTE It is not recommended to perform Bluetooth wireless technology inquiry when high rate 802.11b operation is 
required.

Bluetooth Icon
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Table 3-2 list the COM ports available for the StoneStreet One Bluetooth stack and the Microsoft Bluetooth stack.

Bluetooth Power States

Cold Boot

With StoneStreet One Bluetooth Stack

Performing a cold boot on the MC31XX turns off Bluetooth after initialization (which takes a few moments). It is 
normal to see the Bluetooth icon appear and disappear, as well as a wait cursor, when initialization proceeds in all 
modes.

Table 3-1    Bluetooth Services

Microsoft Bluetooth Stack StoneStreet One Bluetooth Stack

Windows Mobile WinCE Windows Mobile WinCE

Serial Port Service Serial Port Service Serial Port Service Serial Port Service

Dial-Up Networking 
Client Service

Dial-Up Networking Client 
Service

Dial-Up Networking Client 
Service

OBEX Object Push 
Service

OBEX Object Push Client and 
Host Services

OBEX Object Push Client and 
Host Services

HID Client Service HID Client Services HID Client Services

A2DP/AVRCP Service LAN Client Services LAN Client Services

Headset Audio Gateway Client 
Services

Headset Audio Gateway 
Services

Personal Area Networking 
Services

Personal Area Networking 
Services

File Transfer Client and Host 
Services

File Transfer Client and Host 
Services

A2DP/AVRCP Services

Table 3-2    COM Ports

Microsoft Bluetooth Stack StoneStreet One Bluetooth Stack

COM5 COM5

COM9 COM9

COM11

COM21

COM22

COM23



3 - 4 MC31XX Series Mobile Computer User Guide
With Microsoft Bluetooth Stack

Performing a cold boot retain the state of the Bluetooth radio prior to the cold boot.

Warm Boot

With StoneStreet One Bluetooth Stack

Performing a warm boot turns off Bluetooth.

With Microsoft Bluetooth Stack

Performing a warm boot retain the state of the Bluetooth radio prior to the warm boot.

Suspend

When there is an active Bluetooth connection, the Bluetooth radio goes into low power mode maintaining the active 
connection. When there is no active connection, the Bluetooth radio turns off.

With StoneStreet One Bluetooth Stack

With Microsoft Bluetooth Stack

Resume

When the MC31XX resumes, Bluetooth turns on if it was on prior to suspend.

NOTE If there is an active Bluetooth connection between the MC31XX and another Bluetooth device, the MC31XX 
will not timeout. However, if the user presses the Power button on the MC31XX, the MC31XX will suspend 
and upon receiving data from a remote Bluetooth device, the MC31XX will wake from suspend mode. For 
example, Bluetooth scanner sending data to the MC31XX.

NOTE If there is an active Bluetooth connection between the MC31XX and another Bluetooth device and there is no 
data activity, the MC931XX will timeout. However, if the user presses the Power button on the MC31XX, the 
MC31XX will suspend (except when on a call) and upon receiving data from a remote Bluetooth device, the 
MC31XX will wake from suspend mode. For example, headset redial or Bluetooth scanner sending data to 
the MC31XX.
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Using Microsoft Bluetooth Stack with Windows Mobile 6.1
The following sections provide information on using the Microsoft Bluetooth stack with the Windows Mobile 6.1 
operating system.

Turning the Bluetooth Radio Mode On and Off

Turn off the Bluetooth radio to save power or if entering an area with radio restrictions (e.g., an airplane). When the 
radio is off, other Bluetooth devices cannot see or connect to the MC31XX. Turn on the Bluetooth radio to 
exchange information with other Bluetooth devices (within range). Communicate only with Bluetooth radios in close 
proximity.

Enabling Bluetooth

To enable Bluetooth:

1. Tap Wireless Manager and then tap the Bluetooth bar or 

Tap Start > Setting > Connections > Bluetooth icon > Mode tab.

Figure 3-2    Bluetooth Mode Tab

2. Check the Turn On Bluetooth checkbox.

3. Tap ok.

Disabling Bluetooth

To disable Bluetooth:

1. Tap Wireless Manager and then tap the Bluetooth bar or 

Tap Start > Setting > Connections > Bluetooth icon > Mode tab.

2. Un-check the Turn On Bluetooth checkbox.

3. Tap ok.

NOTE To achieve the best battery life turn off radios not in use.
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Discovering Bluetooth Device(s)

The MC31XX can receive information from discovered devices without bonding. However, once bonded, the 
MC31XX and a bonded device exchange information automatically when you turn the Bluetooth radio on. See 
Bonding with Discovered Device(s) on page 3-30 for more information.

To find Bluetooth devices in the area:

1. Ensure that Bluetooth is enabled on both devices.

2. Ensure that the Bluetooth device to discover is in discoverable and connectable modes.

3. Ensure that the two devices are within 30 feet (10 meters) of one another.

4. Tap Start > Settings > Connections tab > Bluetooth icon > Devices tab.

Figure 3-3    Bluetooth - Devices Tab

5. Tap Add new device. The MC31XX begins searching for discoverable Bluetooth devices in the area.

Figure 3-4    Searching for Bluetooth Devices

6. Select a device from the list.

7. Tap Next. The Enter Passcode window appears.

NOTE If Smart-pairing is configured and the device is requesting one of the pre-defined PINs, the Enter 
Passcode window does not appear.
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Figure 3-5    Enter Passcode

8. Enter the Passcode on the other device. The device is added to the Bluetooth list.

Figure 3-6    Bluetooth Connection Confirmation

You are prompted to enter a passcode. If the device has a specific passcode, enter it in the Passcode field and 
tap Next. If the device does not have a specific passcode, enter one in the Passcode field and tap Next. The 
Bluetooth radio tries to connect with the device.

9. If you created a passcode, you will be prompted by the other device to enter the same passcode. Enter the 
created passcode to establish a paired connection. (If you entered a passcode from the device, you shouldn’t 
have to do anything on the other device.)

10. When the connection is complete, a list of matching and supported services on the device appears.

11. Select the services you want to use and tap Finish. The services on the new devices have to be selected or 
else the pairing won’t include those services, even though the devices are paired. If services are not selected, 
you will be continually reprompted for the passcode from the device.

12. The device appears in the list on the main window.

After the passcodes have been accepted on both sides, you have a trusted (“paired”) connection.

Available Services

The MC31XX with Microsoft Bluetooth stack and Windows Mobile 6.1 offers the following services:

• OBEX Object Push via Beam

• Serial Port

• Personal Area Networking

NOTE Some devices might not require a PIN. This depends upon the device’s authentication.
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• HID

• Dial-up Networking

• A2DP/AVRCP.

See the following sections for information on these services.

Object Push Services via Beam

Use the OBEX Push Service to send files and contacts to another Bluetooth device. To transfer files between the 
MC31XX and another Bluetooth enabled device:

1. Ensure that Bluetooth is enabled and discoverable on both devices.

2. Ensure that the two devices are within 30 feet (10 meters) of one another.

3. Tap Start > Programs > File Explorer.

4. Navigate to the file to transfer.

5. Tap and hold on the filename until the pop-up menu appears.

Figure 3-7    File Explorer Window

6. Select Beam File. The MC31XX searches for Bluetooth devices in the area.

7. Tap Tap to send next to the Bluetooth device to send the file to. The MC31XX communicates with the device 
and send the file. When completed, Tap to send changes to Done.

Figure 3-8    Beam File Window

To transfer a contact between the MC31XX and another Bluetooth enabled device:

NOTE You can only send files to a remote device using the Beam function.
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1. Ensure that Bluetooth is enabled and discoverable on both devices.

2. Ensure that the two devices are within 30 feet (10 meters) of one another.

3. Tap Start > Contacts

4. Navigate to the contact to transfer.

5. Tap and hold on the contact until the pop-up menu appears.

Figure 3-9    Contact Window

6. Select Send Contact > Beam. The MC31XX searches for Bluetooth devices in the area.

7. Tap Tap to send next to the Bluetooth device to send the file to. The MC31XX communicates with the device 
and send the contact. When completed, Tap to send changes to Done.

Serial Port Services

Use the wireless Bluetooth serial port connection as you would a physical serial cable connection. Configure the 
application that will use the connection to the correct serial port.

To establish a serial port connection:

1. Ensure that Bluetooth is enabled and discoverable on both devices.

2. Ensure that the two devices are within 30 feet (10 meters) of one another.

3. Tap Start > Settings > Connections tab > Bluetooth icon > Devices tab.

4. Tap Add new device. The MC31XX begins searching for discoverable Bluetooth devices in the area.

5. Select a device from the list.

6. Tap Next. The Enter Passcode window appears.

7. Enter the Passcode and the tap Next. The device is added to the Bluetooth list.

8. In the device list, tap the serial device. The Partnership Settings window displays.

9. Select the Serial Port checkbox.

10. Tap Save.

11. Tap COM Ports tab.

12. Tap New Outgoing Port. The add device window appears.

NOTE If Smart-pairing is configured and the device is requesting one of the pre-defined PINs, the Enter 
Passcode window does not appear.
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13. Select the serial device in the list and then tap Next.

14. Select a COM port from the drop-down list.

15. Tap Finish.

ActiveSync Using Serial Port Services

Use the wireless Bluetooth serial port connection for ActiveSync just as you would a physical serial cable 
connection. You must configure the application that will use the connection to the correct serial port.

To set up a Bluetooth ActiveSync connection:

Before setting up a Bluetooth ActiveSync connection, configure the Bluetooth function of your device.

1. Ensure that Bluetooth is enabled and discoverable on both devices.

2. Ensure that the two devices are within 30 feet (10 meters) of one another.

3. On the computer, click Start > Settings > Control Panel.

4. Double-click Bluetooth Devices.

5. On the Options tab, select the Turn discovery on and Allow Bluetooth devices to connect to this 
computer checkboxes.

Figure 3-10    Computer Bluetooth Devices Window

NOTE No connection is made at this point. An application must open the selected COM port to trigger Microsoft 
Bluetooth stack to open the connection.

NOTE For additional security, disable network bridging on the computer (specifically, bridging to a Remote NDIS 
adapter) before connecting to the computer to pass though to the Internet or a network. For more information 
on network bridging, see Windows Help on your computer.

The instructions below are for computers that support the Windows XP SP2 or later version operating system.
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6. On the COM Ports tab, click Add.

7. Select the Incoming (device initiates the connection) option, then click OK.

Note the number of the COM port that was added.

8. Click OK.

9. Click Start > All Programs > Microsoft ActiveSync.

10. Click File > Connection Settings.

Figure 3-11    ActiveSync Connection Settings

11. On the Allow connections to one of the following drop-down list, select the COM port with the number you 
noted earlier.

12. On the MC31XX, tap Start > Programs > ActiveSync.

13. Tap Menu > Connect via Bluetooth.

Synchronization is automatically initiated. The ActiveSync icon appears on the lower right corner of the Today 
screen.

If an Authentication is required, the Enter Passcode screen appears, type an alphanumeric passkey (PIN 
code), then tap Next; enter the same passkey on the other device.

The passkey is recommended for enhanced security. Your passkey must be between 1 to 16 alphanumeric 
characters.

If you do not want to use a passkey, tap Next.

14. To disconnect the ActiveSync connection, tap the ActiveSync icon on the Today screen.

15. Tap Disconnect.
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Using Microsoft Bluetooth Stack with Windows CE 6.0
The following sections provide information on using the Microsoft Bluetooth stack with Windows CE 6.0 operating 
system.

Power Modes

The Bluetooth radio switches between normal and low power modes automatically. When data transfer is required, 
the radio goes into normal mode. After five seconds of inactivity, the radio goes into low power mode.

Discovering Bluetooth Device(s)

The MC31XX can receive information from discovered devices without bonding. However, once bonded, the 
MC31XX and a bonded device exchange information automatically when you turn the Bluetooth radio on. See 
Bonding with Discovered Device(s) on page 3-30 for more information.

To find Bluetooth devices in the area:

1. Ensure that Bluetooth is enabled on both devices.

2. Ensure that the Bluetooth device to discover is in discoverable and connectable modes.

3. Ensure that the two devices are within 30 feet (10 meters) of one another.

4. Tap Start > Settings > Control Panel > Bluetooth Device Properties icon.

Figure 3-12    Bluetooth Manager

5. Tap Scan Device button. The MC31XX begins searching for discoverable Bluetooth devices in the area. 
Discovered devices appear in the Untrusted list.

Figure 3-13    Searching for Bluetooth Devices

6. Select a device from the Untrusted list.

7. Tap --> button. A dialog box appears.
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8. Tap Yes.

9. The Bluetooth Enter PIN window appears.

Figure 3-14    Enter PIN

10. Enter the PIN on the other device. The device is added to the Trusted list.

You are prompted to enter a PIN. If the device has a specific PIN, enter it in the PIN field and tap Next. If the 
device does not have a specific passcode, enter one in the Passcode field and tap Next. The Bluetooth radio 
tries to connect with the device.

11. If you created a passcode, you will be prompted by the other device to enter the same passcode. Enter the 
created passcode to establish a paired connection. (If you entered a passcode from the device, you shouldn’t 
have to do anything on the other device.)

12. When the connection is complete, a list of matching and supported services on the device appears.

13. Select the services you want to use and tap Finish. The services on the new devices have to be selected or 
else the pairing won’t include those services, even though the devices are paired. If services are not selected, 
you will be continually reprompted for the passcode from the device.

14. The device appears in the list on the main window.

After the passcodes have been accepted on both sides, you have a trusted (“paired”) connection.

Available Services

The MC31XX with Microsoft Bluetooth stack and Windows CE 6.0 offers the Serial Port service.

NOTE Some devices might not require a PIN. This depends upon the device’s authentication.

NOTE In order to connect to the Bluetooth device, the application must create the connection to the remote 
device. Please refer to the MSDN Help for detailed information.
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Using Bluetooth StoneStreet One Bluetooth Stack
The following sections provide information on using the Stone Street One Bluetooth stack.

Turning the Bluetooth Radio Mode On and Off

Turn off the Bluetooth radio to save power or if entering an area with radio restrictions (e.g., an airplane). When the 
radio is off, other Bluetooth devices cannot see or connect to the MC31XX. Turn on the Bluetooth radio to 
exchange information with other Bluetooth devices (within range). Communicate only with Bluetooth radios in close 
proximity.

Disabling Bluetooth

To disable Bluetooth, tap Bluetooth icon > Disable Bluetooth. The Bluetooth icon changes to indicate that 
Bluetooth is disabled.

 

Figure 3-15    Disable Bluetooth

Enabling Bluetooth

To enable Bluetooth, tap Bluetooth icon > Enable Bluetooth. The Bluetooth icon changes to indicate that 
Bluetooth is enabled.

Figure 3-16    Enable Bluetooth

Modes

The BTExplorer application has two modes for managing Bluetooth connections: Wizard Mode and Explorer Mode. 
The Wizard Mode is for novice Bluetooth users and the Explorer Mode is for experienced Bluetooth users. To 
switch between modes, select View > Wizard Mode or View > Explorer Mode.

Wizard Mode

Wizard Mode provides a simple process for discovering and connecting to Bluetooth devices.

NOTE To achieve the best battery life turn off radios not in use.
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Wizard Mode shows the devices and services in a simple Favorites view created by following the step-by-step 
wizard.

Explorer Mode

The Explorer Mode window is easy to navigate and provides greater control to users familiar with Bluetooth. The 
menu bar provides quick access to the options and tools used to connect to devices. To access Explorer Mode, tap 
View > Explorer Mode.

Figure 3-17    Explorer Mode Window

You can also use the “tap and hold” technique to view available options. Scroll bars and view options are similar to 
those on the Windows desktop. The tree structure lists the following sub-items:

• Local Device - This device

• Remote Device - Other Bluetooth devices

• Trusted Devices - Bonded (paired) Bluetooth devices

• Untrusted Devices - Discovered devices that are not bonded

• Favorites - Selected services that are set as Favorite for quick access.

Discovering Bluetooth Device(s)

The MC31XX can receive information from discovered devices without bonding. However, once bonded, the 
MC31XX and a bonded device exchange information automatically when you turn the Bluetooth radio on. See 
Bonding with Discovered Device(s) on page 3-30 for more information.

To find Bluetooth devices in the area:

1. Ensure that Bluetooth is enabled on both devices.

2. Ensure that the Bluetooth device to discover is in discoverable and connectable modes.

3. Ensure that the require profile is enabled on the MC31XX. See Profiles Tab on page 3-42 for more information.

4. Ensure that the two devices are within 30 feet (10 meters) of one another.

5. Tap the Bluetooth icon and select Show BTExplorer. The BTExplorer window appears.

NOTE Switching between Wizard Mode and Explorer Mode closes all active connections.

NOTE Switching between Wizard Mode and Explorer Mode closes all active connections.



3 - 16 MC31XX Series Mobile Computer User Guide
6. Tap Menu > New Connection.The New Connection Wizard appears.

Figure 3-18    BTExplorer Window

7. Select Explore Services on Remote Device or another from the drop-down list and tap Next.

The following actions are available in the drop-down list (actions may vary depending upon configurations):

• Explore Services on Remote Device

• Pair with a Remote Device

• Active Sync via Bluetooth

• Browse Files on Remote Device

• Connect to Headset

• Connect to Internet using Access Point

• Connect to Internet using Phone/Modem

• Connect to Personal Area Network

• Connect to Printer

• Send or Exchange Objects

• Associate Serial Port

• Connect to High-Quality Audio (not available on Windows CE 6.0 devices).

8. BTExplorer searches for Bluetooth devices in the area.

NOTE If favorite connections have already been created, the Favorites screen displays. If no favorite connections 
have been created, the New Connection Wizard screen displays.

NOTE If a device discovery action has not been previously performed, a device discovery is automatically initiated. If 
a device discovery has previously been performed, the device discovery process is skipped, and the 
previously found list of devices displays. To start a new device discovery, tap and hold in the window and select 
Discover Devices from the pop-up menu.
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Figure 3-19    Discover Devices Dialog Box

The discovered devices display in the Select Remote Device window.

Figure 3-20    Select Remote Device Window

9. Select a device from the list and tap Next. The MC31XX searches for services on the selected Bluetooth 
device.

Figure 3-21    Device Services

10. Select a service from the list and press Next. The Connection Favorite Options window appears.

NOTE If the MC31XX discovers a service but the service is not supported, the service icon is grayed-out.
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Figure 3-22    Connection Favorite Options Window

11. In the Favorite Name text box, enter a name for this service that will appear in the Favorite window.

12. Tap Next. The Connection Summary window appears.

13. Tap Connect to add the service to the Favorite window and connect to the service.

Figure 3-23    Favorites Window

Available Services

The MC31XX offers the following services:

• File Transfer

• Dial-Up Networking

• OBEX Object Push

• Headset Audio Gateway

• Serial Port

• Personal Area Networking

• A2DP/AVRCP.

See the following sections for information on these services.

NOTE Some devices might not require a PIN. This depends upon the device’s authentication.
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File Transfer Services

To transfer files between the MC31XX and another Bluetooth enabled device:

1. Ensure that OBEX File Transfer profile is enabled on the MC31XX. See Profiles Tab on page 3-42 for more 
information.

2. Use the Connection Wizard to search for a Bluetooth device. 

3. Select the device and tap Next. The Select Remote Service window appears.

4. Tap Next. The Connection Favorite Options window appears.

5. Tap Next. The Connection Summary window appears.

6. Tap Connect. The remote device’s accessible folders appear.

Figure 3-24    File Transfer Window

7. Double-tap the file to copy. The Save Remote File window appears.

Figure 3-25    Save Remote File Window

8. Tap and hold on the file. A pop-up menu appears.

9. Select the action to perform:

• New - create a new file or folder on the remote device

• Delete - delete the selected file on the remote device.

NOTE Shared folders are a security risk.

NOTE If favorite connections have already been created, the Favorites screen displays. If no favorite connections 
have been created, the New Connection Wizard screen displays.
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• Get File - copy the file from the remote device to the MC31XX.

• Put File - copy a file from the MC31XX to the remote device.

Creating a New File or Folder

To create a new folder or file on the remote device:

1. Tap and hold on the screen and select New > Folder or New > File. The Create New Folder or Create New 
File window appears.

2. Enter the name for the new folder or file.

3. Tap OK to create the new folder or file on the remote device.

Deleting a File

To delete a file from the remote device:

1. Tap and hold on the file to delete and select Delete.

2. In the Delete Remote Device File dialog box tap Yes.

Getting a File

To copy a file from a remote device:

1. Double-tap or tap and hold on the file and select Get. The Save Remote File window appears.

2. Navigate to the directory to save the file.

3. Tap Save. The file is transferred from the remote device to the MC31XX.

Copying a File

To copy a file to a remote device:

1. Tap Action > Put. The Send Local File window appears.

2. Navigate to the directory to save the file and select a file.

3. Tap Open. The file copies from the MC31XX to the remote device.

Connecting to the Internet Using an Access Point

This section explains how to access a Bluetooth-enabled LAN access point (AP) for a network connection. Use 
Internet Explorer to connect to a server.

1. Ensure the MC31XX is discoverable and connectable. See Device Info Tab on page 3-33.

2. Ensure that the Personal Area Networking profile is enabled on the MC31XX. See Profiles Tab on page 3-42 
for more information.

3. Use the Connection Wizard to search for a Bluetooth AP.

4. Select the Personal Area Network or Network Access service and select Connect from the pop-up menu. 
The MC31XX connects with the access point.

NOTE If favorite connections have already been created, the Favorites screen displays. If no favorite connections 
have been created, the New Connection Wizard screen displays.
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5. Tap Start > Internet Explorer. The Internet Explorer window appears.

6. In the address field, enter an internet address and tap the Enter button. The web page loads.

Dial-Up Networking Services

Dial-up networking allows the user to connect the MC31XX to a Bluetooth Phone and use the Bluetooth Phone as 
a modem to connect to an office network or ISP.

Before setting up dial-up networking, obtain dial-up information and other necessary settings (username, password 
and domain name, if required) for the office network or ISP.

To create a new Bluetooth connection:

1. Ensure the Bluetooth Phone is discoverable and connectable.

2. Ensure that the Dial-Up Networking profile is enabled on the MC31XX. See Profiles Tab on page 3-42 for 
more information.

3. Tap Menu > New Connection.

4. Select Explore Services on Remote Device or another from the drop-down list and tap Next.

5. BTExplorer searches for Bluetooth devices in the area.

The discovered devices display in the Select Remote Device window.

6. Select the Bluetooth Phone from the list and tap Next. The MC31XX searches for services on the Bluetooth 
Phone.

Figure 3-26    Select Remote Service Window

7. Select Dial-up Networking Gateway service from the list and tap Next. The Connection Favorite Options 
window appears.

NOTE Network Access profile is not supported.
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Figure 3-27    Connection Favorite Options Window

8. In the Favorite Name text box, enter a name for this service that will appear in the Favorite window.

9. Tap Next. The Connection Summary window appears.

10. Tap Connect. The Select Dial-up Networking Entry window appears.

Figure 3-28    Select Dial-up Networking Entry Window

11. Select the entry and tap OK. The MC31XX begins to communicate with the Bluetooth phone. If required, the 
phone requests permission to communicate with the MC31XX.

12. Confirm the connection on the phone. The Network Log On window appears.

Figure 3-29    Network Log On Window

13. In the User name text box, enter the user name for this connection.

14. In the Password text box, enter the password for this connection.

15. In the Domain text box, enter the domain name for this connection, if required.

16. Tap Finish or Connect.

17. The phone begins dialing and connects to the network.
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18. To end a session, tap the Connection icon and then tap Disconnect in the dialog box.

Add a Dial-up Entry

To add a dial-up entry:

1. In the Select Dial-up Networking Entry window, tap and hold and then select Add Entry from the pop-up 
menu.

Figure 3-30    Select Dial-up Networking Entry Window

2. The Add Phone Book Entry window appears.

Figure 3-31    Add Phone Book Entry Window

3. In the Name for the connection text box, enter a name for this connection.

4. In the Country Code text box, enter the country code for the country that you are calling.

5. In the Area Code text box, enter the area code.

6. In the Phone Number text box, enter the phone number.

7. Tap OK.

Object Exchange Push Services

Object Exchange (OBEX) is a set of protocols that allows sharing objects such as Contacts or pictures using 
Bluetooth.

To exchange contact information with another Bluetooth enabled device:

1. Ensure the MC31XX is discoverable and connectable. See Device Info Tab on page 3-33.

2. Ensure that the OBEX Object Push profile is enabled on the MC31XX. See Profiles Tab on page 3-42 for 
more information.
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3. Use the Connection Wizard to search for a Bluetooth device.

4. Select the device and tap Next.

5. Select the OBEX Object Push service and select Next. The Connection Favorite Options window appears.

6. Tap Next. The Connection Summary window appears.

7. Tap Connect. The OBEX Object Push window appears.

8. In the Action drop-down list, select one of the following options: Send Contact Information, Swap Contact 
Information, Fetch Contact Information, or Send a Picture.

Sending a Contact

To send a contact to another device:

1. Tap and hold on OBEX Object Push and select Connect. The OBEX Object Push window appears.

Figure 3-32    OBEX Object Push Window

2. In the Action: drop-down list, select Send Contact Information.

3. Tap . The Select Contact Entry window appears.

Figure 3-33    Select Contact Entry Window

4. Select a contact to send to the other device.

NOTE If favorite connections have already been created, the Favorites screen displays. If no favorite connections 
have been created, the New Connection Wizard screen displays.

NOTE Prior to sending and receiving contacts, a default contact must be set up before attempting to send a 
contact.



Using Bluetooth 3 - 25
5. Tap OK.

6. Tap OK to send the contact to the other device and display a confirmation dialog box on the other device to 
accept the contact. A Send Contact dialog appears.

7. Tap Ok.

Swapping Contacts

To swap contacts with another device:

1. Tap and hold on OBEX Object Push and select Connect. The OBEX Object Push window appears.

Figure 3-34    OBEX Object Push Window

2. In the Action: drop-down list, select Swap Contact Information.

3. Tap . The Select Contact Entry window appears.

Figure 3-35    Select Contact Entry Window

4. Select a contact to send to the other device.

5. Tap OK.

6. Tap OK to swap contacts with the other device and display a confirmation dialog box on the other device to 
accept the contact.

7. Tap Ok.

NOTE Prior to swapping contacts, a default contact must be set up before attempting to send a contact.

Ensure that the MC31XX is connectable.
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Fetching a Contact

To fetch a contact from another device:

1. Tap and hold on OBEX Object Push and select Connect. The OBEX Object Push window appears.

Figure 3-36    OBEX Object Push Window

2. In the Action: drop-down list, select Fetch Contact information.

3. Tap OK. The contact on the other device is copied.

Sending a Picture

To send a picture to another device:

1. Tap and hold on OBEX Object Push and select Connect. The OBEX Object Push window appears.

Figure 3-37    OBEX Object Push Window

2. In the Action: drop-down list, select Send A Picture.

3. Tap . The Send Local Picture window appears.

NOTE Prior to sending and receiving contacts, a default contact must be set up before attempting to send a contact.

Ensure that the MC31XX is connectable.
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Figure 3-38    Send Local Picture Window

4. Navigate to the picture to send to the other device.

5. Tap Open.

6. Tap OK to send the picture to the other device and display a confirmation dialog box on the other device to 
accept the picture. A Send Picture dialog appears.

7. Tap Ok.

Headset Services

To connect to a Bluetooth headset:

1. Ensure the MC31XX is connectable (required when automatic re-connect is initiated). See Device Info Tab on 
page 3-33.

2. Ensure that the Headset profile is enabled on the MC31XX. See Profiles Tab on page 3-42 for more 
information.

3. Use the Connection Wizard to search for a Bluetooth headset.

4. Select the device and tap Next.

5. Select the Headset service name and select Connect. The MC31XX connects to the headset. Refer to the 
headset user manual for instructions on communicating with a Bluetooth device.

6. Press the communication button on the headset. This routes both system and voice call audio to the headset.

7. When a call is received on the MC31XX, tap the Accept button to answer the call.

8. Press the communication button on the headset to route the audio back to the MC31XX.

Serial Port Services

Use the wireless Bluetooth serial port connection as you would a physical serial cable connection. Configure the 
application that will use the connection to the correct serial port.

NOTE Newer Bluetooth headsets are device dependant and remember the last device they connected to. If problems 
occur while connecting to the headset, place the headset in discovery mode. Refer to the headset user manual 
for more information.

NOTE When using a Bluetooth headset with Headset Services, you cannot accept or end a call from the headset. 
You must accept or end a call on the MC31XX. 
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To establish a serial port connection:

1. MC31XXUse the Connection Wizard to search for a Bluetooth serial device.

2. Select the device and tap Next. The Connection Favorite Options window appears.

3. In the Local COM Port: drop-down list select a COM port.

4. Tap Finish.

ActiveSync Using Serial Port Services

Use the wireless Bluetooth serial port connection for ActiveSync just as you would a physical serial cable 
connection. You must configure the application that will use the connection to the correct serial port.

Figure 3-39    ActiveSync Connection Settings Window on PC

To establish an ActiveSync connection:

1. Ensure that the Sync profile is enabled on the MC31XX. See Profiles Tab on page 3-42 for more information.

2. Use the Connection Wizard to search for a Bluetooth device, such as a PC. In the drop-down list select 
ActiveSync via Bluetooth.

3. Select the device and tap Next. The Connection Favorite Options window appears.

4. Tap Connect. The Remote Service Connection window appears.

Figure 3-40    Remote Service Connection Window

NOTE By default, COM ports COM5, COM9, COM11, COM21, COM22 and COM23 are Bluetooth virtual ports. If an 
application opens one of these ports, the Bluetooth driver activates and guides you through a Bluetooth 
connection.
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5. In the Service Type drop-down list, select Active Sync.

6. Tap OK. The MC31XX connects the PC and an ActiveSync session begins.

7. Tap Finish. The Connection Favorite Options window appears.

8. To end the session, tap the ActiveSync icon in the Favorite window and select Disconnect from the pop-up 
window.

Personal Area Network Services

Connect two or more Bluetooth devices to share files, collaborate, or play multi-player games. To establish a 
Personal Area Network connection:

1. Ensure that the Personal Area Networking profile is enabled on the MC31XX. See Profiles Tab on page 3-42 
for more information.

2. Use the Connection Wizard to search for a Bluetooth device.

3. Select the device and tap Next. The Connection Favorite Options window appears.

4. Tap Next. The Connection Summary window appears.

5. Tap Connect. The MC31XX connects to the Bluetooth device.

A2DP/AVRCP Services

A2DP/AVRCP is used to connect to a high-quality stereo headset:

1. Ensure the MC31XX is connectable (required when automatic re-connect is initiated). See Device Info Tab on 
page 3-33.

2. Ensure that the remote Bluetooth device is in discoverable mode. See the devices user manual for 
instructions.

3. Ensure that the A2DP/AVRCP profile is enabled on the MC31XX. See Profiles Tab on page 3-42 for more 
information.

4. Tap Menu > Settings > Services tab.

5. Tap Add button.

6. Select Advanced Audio Distribution Services.

7. Tap OK. The Edit Local Services window appears.

8. Tap OK twice.

9. Tap Menu > New Connection.

10. Select Connect to High-Quality Audio from the drop-down list.

11. Tap Next.

12. Select the device and tap Next.

13. Enter the PIN Code for the remote device and then tap OK. The Connection Favorite Options window 
appears.

NOTE This profile supports Ad-hoc and PAN User. Network Access Profile is not supported.
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14. Tap Next.

15. Tap Connect. The MC31XX connects to the high-quality audio headset.

For stereo headsets that can use hands-free services, connect to the hands-free service after connecting to the 
A2DP service:

1. Tap Menu > New Connection.

2. Select Connect to Headset from the drop-down list.

3. Tap Next.

4. Select the stereo headset and tap Next.

5. Select the Hands-Free unit service and then tap Next.

6. Tap Next.

7. Tap Connect.

Connect to a HID Device

The MC31XX can connect to an Human Interface Device (HID) device such as a Bluetooth keyboard:

1. Ensure the MC31XX is connectable (required when automatic re-connect is initiated). See Device Info Tab on 
page 3-33.

2. Ensure that the remote Bluetooth device is in discoverable mode. See the device user manual for instructions.

3. Ensure that the HID Client profile is enabled on the MC31XX. See Profiles Tab on page 3-42 for more 
information.

4. Tap Menu > New Connection.

5. Select Explore Services on Remote Device from the drop-down list.

6. Tap Next.

7. Select the device and tap Next.

8. Select the service and tap Next.

9. The Connection Favorite Options window appears.

10. Tap Next.

11. Tap Connect. The MC31XX connects to the HID device.

Bonding with Discovered Device(s)

A bond is a relationship created between the MC31XX and another Bluetooth device in order to exchange 
information in a secure manner. Creating a bond involves entering the same PIN on the two devices. After creating 
a bond and turning on the Bluetooth radios, the devices recognize the bond and can exchange information without 
re-entering a PIN.

To bond with a discovered Bluetooth device:

NOTE If favorite connections have already been created, the Favorites screen displays. If no favorite connections 
have been created, the New Connection Wizard screen displays.
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1. Tap the Bluetooth icon and select Show BTExplorer. The BTExplorer window appears.

2. Tap Menu > New Connection. The New Connection Wizard window appears.

3. In the drop-down list, select Pair with Remote Device.

4. Tap Next. The Select Remote Device window appears.

Figure 3-41    Select Remote Device Window

5. Select a device from the list and tap Next. The PIN Code Request window appears.

Figure 3-42    Connection Favorite Options Window

6. In the PIN Code field, enter the PIN code.

7. Tap OK. The Pairing Status window displays.

NOTE Devices discovered previously are listed to save time. To start a new device discovery, tap and hold on the list 
area and select Discover Devices from the pop-up menu.



3 - 32 MC31XX Series Mobile Computer User Guide
Figure 3-43    Pairing Status Window

8. Tap Finish. The devices are successfully paired. The device name moves to the Trusted Devices window.

Deleting a Bonded Device

To delete a device no longer needed:

1. Tap the Bluetooth icon and select Show BTExplorer. The BTExplorer window appears.

2. Tap Menu > Trusted Devices. The Trusted Devices window appears.

3. Tap and hold on the device select Delete Link Key in the pop-up menu.

4. A confirmation dialog appears. Tap Yes.

Accepting a Bond

When a remote device wants to bond with the MC31XX, enter a PIN when requested to grant permission.

1. Ensure that the MC31XX is set to discoverable and connectable. See Bluetooth Settings on page 3-33. When 
prompted to bond with the remote device the PIN Code Request window appears.

Figure 3-44    PIN Code Request Window

2. In the PIN Code: text box, enter the same PIN entered on the device requesting the bond. The PIN must be 
between 1 and 16 characters.

3. In the Device Name: text box, edit the name of the device requesting the bond, if desired.
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4. Tap OK to create the bond. The MC31XX can now exchange information with the other device.

Bluetooth Settings

Use the BTExplorer Settings window to configure the operation of the BTExplorer application. Tap Menu > 
Settings. The BTExplorer Settings window appears.

Device Info Tab

Use the Device Info tab to configure the MC31XX’s Bluetooth connection modes.

Figure 3-45    BTExplorer Settings - Device Info Tab

Services Tab

Use the Services tab to add or delete Bluetooth services.

Figure 3-46    BTExplorer Settings - Services Tab

To add a service:

Table 3-3    Device Info Tab Data

Item Description

Device Name Displays the name of the MC31XX.

Discoverable Mode Select whether or not the MC31XX is discoverable by other Bluetooth devices.

Connectable Mode Select whether or not the MC31XX is connectable by other Bluetooth devices.

NOTE Ensure that the MC31XX is discoverable and connectable when remote devices use MC31XX services.
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1. Tap Add. The Add Local Service window displays.

Figure 3-47    Add Local Service Window

2. In the list, select a service to add.

3. Tap OK. The Edit Local Service window displays for the selected service.

4. Select the appropriate information and then tap OK. See the following sections for information on the available 
services.

Dial-Up Networking Service

Dial-up Networking allows other Bluetooth devices to access a dial-up modem.

Figure 3-48    BTExplorer Settings - Dial-up Networking Information

Table 3-4    Dial-up Networking Information Data

Item Description

Service Name Displays the name of the service.

Service Security Select the type of security from the drop-down list. Options are None, Authenticate, or 
Authenticate/Encrypt.
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File Transfer Service

File transfer allows other Bluetooth devices to browse files.

Figure 3-49    BTExplorer Settings - File Transfer Information

Local COM Port Select the COM port.

Local Baud Rate Select the communication baud rate.

Local Port Options Select the port option.

Table 3-5    File Transfer Information Data

Item Description

Service Name Displays the name of the service.

Service Security Select the type of security from the drop-down list. Options are None, Authenticate, 
or Authenticate/Encrypt.

Root Directory Select the directory that other Bluetooth devices can access.

File Permissions Select the file permissions for the selected directory. Check the appropriate box to 
grant read access, write access, and delete access.

Table 3-4    Dial-up Networking Information Data

Item Description
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Headset Audio Gateway Service

Headset Service Audio Gateway allows connection to headset devices.

Figure 3-50    BTExplorer Settings - Headset Audio Gateway

OBEX Object Push Service

OBEX Object Push allows other Bluetooth devices to push contacts, business cards, pictures, appointments, and 
tasks to the MC31XX.

Figure 3-51    BTExplorer Settings - OBEX Exchange Information

Table 3-6    Headset Audio Gateway Data

Item Description

Service Name Lists the name of the audio service.

Table 3-7    OBEX Exchange Information Data

Item Description

Service Name Displays the name of the service.
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Personal Area Networking Service

Personal Area Networking hosts a Personal Area Network which allows communication with other Bluetooth 
devices.

Figure 3-52    BTExplorer Settings - Personal Area Networking

Serial Port Service

Serial port allows other Bluetooth devices to access COM ports.

Service Security Select the type of security from the drop-down list. Options are None, 
Authenticate, or Authenticate/Encrypt.

Do not allow clients to push objects Disables clients from pushing objects to the MC31XX.

Inbox Directory Select a directory where another Bluetooth device can store files.

Table 3-8    Personal Area Networking Data

Item Description

Service Name Displays the name of the service.

Service Security Select the type of security from the drop-down list. Options are None, 
Authenticate, or Authenticate/Encrypt.

Support Group Ad-Hoc 
Networking

Select to enable Ad-Hoc networking.

Table 3-7    OBEX Exchange Information Data

Item Description
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Figure 3-53    BTExplorer Settings - Serial Port Services

Advanced Audio Distribution Service

Advanced Audio Distribution hosts connects from Bluetooth devices supporting high-quality stereo audio.

Figure 3-54    BTExplorer Settings - Advanced Audio Distribution

Table 3-9    Serial Port Services Data

Item Description

Service Name Displays the name of the service.

Service Security Select the type of security from the drop-down list. Options are None, Authenticate, or 
Authenticate/Encrypt.

Local COM Port Select the COM port.

Local Baud Rate Select the communication baud rate.

Local Port Options Select the port option.

Table 3-10    Advanced Audio Distribution Data

Item Description

Service Name Lists the name of the audio service.
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Audio Video Remote Control Service

Audio Video Remote Control hosts connections from Bluetooth devices supporting audio remote-control 
functionality.

Figure 3-55    BTExplorer Settings - Audio Video Remote Control

Security Tab

Security settings allows you to set global security policies for Bluetooth. Note that these settings are only active on 
local Services that are set to Authenticate or Authenticate/Encryption. You can set authentication on local Services 
under the Services tab.

To adjust the security settings for an individual service, select the Services tab first, then select the individual 
service, then Properties.

Figure 3-56    BTExplorer Settings - Security Tab

Table 3-11    Audio Video Remote Control Data

Item Description

Service Name Lists the name of the audio service.

NOTE To use PIN Code, select Authenticate or Authenticate/Encrypt from the Service Security drop-down 
list on each local service.
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Discovery Tab

Use the Discovery tab to set and modify discovered devices.

Figure 3-57    BTExplorer Settings - Discovery Tab

Virtual COM Port Tab

Virtual COM Port defines which COM ports BTExplorer attempts to use for virtual COM ports. Check the 
appropriate checkbox to use the port as a virtual COM port. When finished, choose Apply to enforce changes, or 
Revert to restore the original settings.

Table 3-12    Security Tab Data

Item Description

Use PIN Code (Incoming 
Connection)

Select for automatic use of the PIN code entered in the PIN Code text box. 
It is recommended not to use this automatic PIN code feature. See Security 
on page 3-2 for more information.

PIN Code Enter the PIN code.

Encrypt Link On All Outgoing 
Connections

Select to enable or disable encryption on all outgoing connections to other 
Bluetooth devices.

Table 3-13    Discovery Tab Data

Item Description

Inquiry Length Sets the amount of time the MC31XX takes to discover Bluetooth devices in 
the area.

Name Discovery Mode Select either Automatic or Manual to automatically attempt to discover a 
Bluetooth device's name after finding the device.

Discovered Devices - Delete 
Devices

Deletes all discovered devices and link keys from memory.

Discovered Devices - Delete 
Linked Keys

Removes all pairing from remote Bluetooth devices, and makes them all 
un-trusted.
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Figure 3-58    BTExplorer Settings - Virtual COM Port Tab

HID Tab

Use the HID tab to select The Human Interface Device Profile programming interface defines the protocols and 
procedures to be used to implement HID capabilities.

Provides support for devices such as mice, joysticks, keyboards.

Table 3-14    Virtual COM Port Tab Data

Item Description

COM5:Bluetooth Enable or disable COM Port 5.

COM9:Bluetooth Enable or disable COM Port 9.

COM11:Bluetooth Enable or disable COM Port 11.

COM21:Bluetooth Enable or disable COM Port 21.

COM22:Bluetooth Enable or disable COM Port 22.

COM23:Bluetooth Enable or disable COM Port 23.
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Figure 3-59    BTExplorer Settings - HID Tab

Profiles Tab

Use the Profile tab to load or remove Bluetooth services profiles. If a profile is not used, it can be removed to save 
memory.

Figure 3-60    BTExplorer Settings - Profile Tab

1. Tap a check box next to the profile to load (activate).

The Serial Port profile is always active and cannot be removed.

2. Tap Select All to select all profiles or tap Deselect All to deselect all profiles.

3. Tap Apply to activate the profiles and then Close to exit the application.

Table 3-15    HID Tab Data

Item Description

Enable Key Repeat Enables key repeat functionality.

Delay To increase key repeat delay, drag the Delay slider to the right. To decrease 
key repeat delay, drag the Delay slider to the left.

Rate To increase key repeat speed, drag the Rate slider to the left. To decrease 
key repeat speed, drag the Rate slider to the right.
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System Parameters Tab

Figure 3-61    BTExplorer Settings - System Parameters Tab

Miscellaneous Tab

Figure 3-62    BTExplorer Settings - Miscellaneous Tab

Table 3-16    System Parameters Tab Data

item Description

Page Timeout Sets the amount of time the MC31XX searches for a device before moving 
on the next device.

Link Supervision Timeout Sets the amount of time that the MC31XX will wait for a device to come back 
into range after it has gone out of range. If the device does not come back 
into range by the set time, the MC31XX drops the connection.

Table 3-17    Miscellaneous tab Data

Item Description

Highlight Connections Select the connection type to highlight when connected. In the Wizard Mode, 
the only options are Favorites or None. In the Explorer Mode the options are 
None, Tree View Only, List View Only, or Tree and List View.

Apply Text Style Select the text style to apply to the connection text.

Apply Text Color Select the text color to apply to the connection text.
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Chapter 4 Accessories
Introduction
The MC31XX accessories provide a variety of product support capabilities. Accessories include cradles, cables 
and spare battery chargers. Table 4-1 lists the MC31XX accessories.

Table 4-1    MC31XX Accessories

Accessory Part Number Description

Cradles

Single Slot Serial/USB Cradle CRD3000-1001RR Charges the mobile computer main battery and a spare 
battery, and synchronizes the mobile computer with a 
host computer through either a serial or USB 
connection.

Four Slot Ethernet Cradle CRD3000-4001ER Charges up to four mobile computers and provides 
Ethernet communications.

Four Slot Charge Only Cradle CHS3000-4001CR Charges up to four mobile computers.

Mounting Bracket 8710-050006-01R Used to mount four slot cradles onto a wall.

Chargers

Four Slot Spare Battery 
Charger

SACX000-4000CR Charges up to four mobile computer spare batteries.

Universal Battery Charger 
(UBC)

UBC2000-I500DR Chargers up to four batteries.

MC31XX Universal Battery 
Charger Adapter (UBC)

21-32665-45AR Adapts the UBC for use with MC31XX batteries.

UBC Mounting Bracket KT-32665-01R Used to mount UBC onto a wall.

Charge Only Cable 25-70103-03R Plugs into a vehicle cigarette lighter to charge the 
mobile computer.

Auto-charge Cable 25-67873-03R Provides power to the mobile computer
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Power Supply for Single Slot 
Serial/USB Cradle

KT-14000-148R Provides power to the Single Slot Serial/USB Cradle 
and Four Slot Battery Charger.

Power Supply for Four Slot 
Cradles

50-14000-241R Provides power to the Four Slot Charge Only and 
Ethernet Cradles.

Power Supply for Charging 
Cables

50-14000-249R Provides power to the charge only, serial cable and 
USB cable.

US AC Line Cord 23844-00-00R Provides power to the 3-wire power supplies.

Cables

USB Client Charge Cable 25-67868-03R Provides USB client communication capabilities and 
charges the mobile computer.

USB Host Charge Cable 25-67869-03R Provides USB host communication capabilities and 
charges the mobile computer.

RS232 Charge Cable 25-67866-03R Provides RS232 communication capabilities and 
charges the mobile computer.

O’Neil Printer Cable 25-91512-01R Provides printer specific communication capabilities.

Zebra Printer Cable 25-91513-01R Provides printer specific communication capabilities.

Zebra Road Warrior Printer 
Cable

25-91514-01R Provides printer specific communication capabilities.

Single Slot Cradle RS232 
Cable

25-63852-01R Provides serial host communication through the Single 
Slot Serial/USB cradle.

Single Slot Cradle USB Cable 25-68596-01R Provides USB communication through the Single Slot 
Serial/USB cradle.

Miscellaneous

Magnetic Stripe Reader MSR3000-100R Reads magnetic stripe cards.

Modem Dongle MDM9000-100R Provides modem connectivity through mobile computer 
or Single Slot Serial/USB cradle.

Modem Adapter Cable 25-63856-01R Connects Modem Dongle to Single Slot Serial/USB 
cradle.

Cradle Modem Kit KT-MC3000SERMODE
MR

Provides modem connectivity to the Single Slot 
Serial/USB cradle. Kit includes Modem Dongle and 
Modem Adapter Cable.

Modem Kit KT-70924-01R Provides modem connectivity to the mobile computer. 
Kit includes Modem Dongle and Modem Cable.

Modem Cable 25-70924-01R Connects the Modem Dongle to the mobile computer.

Table 4-1    MC31XX Accessories (Continued)

Accessory Part Number Description
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Headset Adapter Cable: 
MC3100 2.5 mm jack with 
unique locking screw to bare 
wires

25-124389-01R Connects a headset with unique Quick Disconnect 
Connector to the mobile computer. Bare wires can be 
soldered to user defined unique Quick Disconnect 
Connector.

Headset Adapter cable: 
MC3100 2.5mm jack with 
unique locking screw to 
Headsets like VXI and RCH50

25-124411-01R Connects a VXI and RCH50 headset to the mobile 
computer.

MC31XXR Audio Jack Cover 11-128366-02R Replacement audio jack cover for the MC31XXR 
(5-pack).

MC31XXS Audio Jack Cover 11-128366-01R Replacement audio jack cover for the MC31XXS 
(5-pack)

MC3190G Audio Jack Cover 11-128366-03R Replacement audio jack cover for the MC3190G 
(5-pack)

2740 mAh Battery BTRY-MC3XKAB0E
BTRY-MC3XKAB0E-10
BTRY-MC3XKAB0E-50

Replacement standard capacity (1X) battery.
10-pack
50-pack.

4800 mAh Battery BTRY-MC31KAB02
BTRY-MC31KAB02-10
BTRY-MC31KAB02-50

Replacement extended capacity (2X) battery.
10-pack
50-pack.

UBC Power Supply Kit KT-32665-02R Provides power to the Universal Battery Charger.

DC Line Cord 50-16002-042R Provides power from the power supply to the Four Slot 
Ethernet cradle or Four Slot Charge Only cradle.

MC31XXR/S Stylus 11-42794-03R Replacement stylus (3-pack).

MC31XXR/S Stylus 11-42794-50R Replacement stylus (50-pack).

MC31XXR/S Tether 11-42722-03R Replacement tether (3-pack).

MC31XXR/S Tether 11-42722-50R Replacement tether (50-pack).

MC31XXR/S Stylus and Tether 
Kit

11-43912-03R Replacement stylus and tether kit (3-pack).

MC31090G Stylus KT-68144-10R Replacement stylus for MC3190G (3-pack).

MC3190G Stylus KT-68144-50R Replacement stylus for MC3190G (50-pack).

MC3190G Stylus and Tether KT-81680-03R Replacement stylus and tether for MC3190G (3-pack).

MC3190G Stylus and Tether KT-81680-50R Replacement stylus and tether for MC3190G (50-pack).

MC3190G Handstrap SG-MC3123242-01R Replacement handstrap for MC3190G.

MC3190G Handstrap Button KT-97258-01R Replacement button for MC3190G handstrap 
(250-pack).

Table 4-1    MC31XX Accessories (Continued)

Accessory Part Number Description
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MC31XXR/S Handstrap SG-MC3123243-01R Replacement handstrap for MC31XXR and MC31XXS.

MC31XX 1X Battery Door KT-128372-01R Replacement 1X battery door for MC31XXR and 
MC31XXS.

MC31XX 2X Battery Door KT-128373-01R Replacement 2X battery door for MC31XXR and 
MC31XXS.

MC3190G 2X Battery Door KT-128374-01R Replacement 2X battery door for MC3190G.

Plastic Holster 8710-050005-01R Provides a clip on holder for the MC31XXR and 
MC31XX S.

Fabric Holster SG-MC3021212-01R Provides a soft, clip on holder and a shoulder strap for 
the mobile computer.

Fabric Holster 11-76201-02R Provides a soft holder for MC3190G and used with a 
shoulder strap.

Belt 11-08062-02R Belt for fabric holster.

MC3190G Rubber Boot 11-72959-04R Provides additional protection for both the laser and 
imager configurations.

MC31XXS Rubber Boot 11-70899-04R Provides additional protection for both the laser and 
imager configurations.

MC31XXR Rubber Boot BOOTSCANTURRETR Provides additional protection for the MC31XXR.

Screen protector KT-82057-03R Replacement screen protectors (3-pack).

Table 4-1    MC31XX Accessories (Continued)

Accessory Part Number Description
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Single Slot Serial/USB Cradle

The Single Slot Serial/USB cradle:

• Provides 5.4VDC power for operating the mobile computer, charging the battery and charging a spare 
battery.

• Provides a serial port and a USB port for data communication between the mobile computer and a host 
computer or other serial devices (e.g., a printer).

• Synchronizes information between the mobile computer and a host computer. With customized or third party 
software, it can also synchronize the mobile computer with corporate databases.

• Provides serial connection through the serial pass-through port for communication with a serial device, such 
as a host computer. For communication setup procedures, refer to the MC31XX Mobile Computer Integrator 
Guide.

• Provides USB connection through the USB pass-through port for communication with a USB device, such as 
a host computer. For communication setup procedures, refer to the MC31XX Mobile Computer Integrator 
Guide. 

Battery Charging

The Single Slot Serial/USB cradle can charge the mobile computer main battery and a spare battery 
simultaneously.

To charge the mobile computer:

1. Slide the mobile computer into the mobile computer slot. The mobile computer amber Charge LED Indicator, 
indicates the mobile computer battery charging status. The Standard Battery charges in less than five hours 
and the Extended Life Battery charges in less than eight hours. See Table 4-2 for charging status indications.

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-2.
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Figure 4-1    Single Slot Serial/USB Cradle

2. When charging is complete, remove the mobile computer from the mobile computer slot.

To charge the spare battery:

1. Insert the spare battery into the spare battery charging slot, bottom first, and pivot the top of the battery down 
onto the contact pins. 

2. Gently press down on the battery to ensure proper contact. 

3. The Spare Battery Charging LED (see Figure 4-1 on page 4-6) indicates the spare battery charging status. The 
Standard Battery charges in less than five hours and the Extended Life Battery charges in less than eight 
hours. See Table 4-2 for charging status indications.

4. When charging is complete, press the battery clip and lift the battery out of the slot.

LED Charge Indications

The Single Slot Serial/USB cradle uses the mobile computer amber Charge LED Indicator to indicate the battery 
charging status and the Spare Battery Charging LED to indicate spare battery charging status. See Table 4-2 for 
charging status indications.

Indicator
LED Bar

Mobile
Computer Slot

Spare Battery

Spare Battery
Charging

LED

Power Port

Serial PortUSB Port

Spare Battery 
Charging Slot

Battery 
ClipCharge LED

Indicator
(amber)

WARNING! Do not use a tool to remove the battery.
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Table 4-2     LED Charging Status Indicators

LED Indication

Mobile Computer Charging (LED on mobile computer)

Off Mobile computer not placed correctly in the cradle; cable not connected correctly; 
charger is not powered.

Fast Blinking Amber Error in charging; check placement of mobile computer. 

Slow Blinking Amber Mobile computer is charging.

Solid Amber Charging complete.
Note: When the battery is initially inserted in the mobile computer, the amber LED flashes 
once if the battery power is low or the battery is not fully inserted.

Spare Battery Charging (LED on cradle)

Off No spare battery in slot; spare battery not placed correctly; cradle is not powered.

Fast Blinking Amber Error in charging; check placement of spare battery. 

Slow Blinking Amber Spare battery is charging.

Solid Amber Charging complete.
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Four Slot Cradles 

There are two four slot cradles, Four Slot Charge Only cradle and Four Slot Ethernet cradle. The Four Slot 
Ethernet cradle provides Ethernet communications. Both four slot cradles:

• Provide 5.4 VDC power for operating the mobile computer and charging the battery.

• Simultaneously charges up to four mobile computers.

Battery Charging

The four slot cradle can charge up to four mobile computers simultaneously. To charge the mobile computer:

1. Slide the mobile computer into the mobile computer slot.

Figure 4-2    Four Slot Cradles

2. The mobile computer amber Charge LED Indicator, indicates the mobile computer battery charging status. The 
Standard Battery usually charges in less than five hours and the Extended Life Battery usually charges in less 
than eight hours. See Table 4-2 for charging status indications.

3. When charging is complete, remove the mobile computer from the cradle.

LED Charge Indications

The Four Slot cradles use the mobile computer amber Charge LED Indicator to indicate the battery charging 
status. See Table 4-2 on page 4-7 for charging status indications. 

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-2.

Scan/Charge Indicator LED Bar 

Mobile Computer Slot 

Charge LED Indicator (amber) 

Speed LED (Ethernet Cradle Only)

Link LED (Ethernet Cradle Only)

Power LED (Charge Only Cradle)
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Power LED

The green Power LED (only on the Four Slot Charge Only cradle) lights to indicate that the Four Slot Charge Only 
cradle is connected to a power source.

Speed LED

The green Speed LED (only on the Four Slot Ethernet cradle) lights to indicate that the transfer rate is 100 Mbps. 
When it is not lit it indicates that the transfer rate is 10 Mbps.

Link LED

The yellow Link LED (only on the Four Slot Ethernet cradle) blinks to indicate activity, or stays lit to indicate that a 
link is established. When it is not lit, it indicates that there is no link.
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Four Slot Spare Battery Charger 

The Four Slot Spare Battery Charger simultaneously charges up to four spare batteries.

Spare Battery Charging

To charge up to four MC31XX spare batteries:

1. Insert the spare battery into the spare battery charging slot, bottom first.

2. Pivot the top of the battery down onto the contact pins.

Figure 4-3    Four Slot Spare Battery Charger

3. Gently press down on the battery to ensure proper contact. The Standard Battery usually charges in less than 
five hours and the Extended Life Battery usually charges in less than eight hours. See Table 4-2 on page 4-7 
for charging status indications.

4. When charging is complete, press the battery clip and lift battery out of the slot.

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-2.

Power Supply

Spare 
Batteries

Spare
Battery

Charging
Slot

Spare Battery
Charging
LEDs (4)

Battery 
Clip

1

2

WARNING! Do not use a tool to remove the battery.
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LED Charge Indications

The Spare Battery Charging LEDs indicate the spare battery charging status. The Spare Battery Charging LEDs 
are arranged in the same pattern as the spare battery charging slots so that the charging status of each battery can 
be identified. See Table 4-2 on page 4-7 for charging status indications. 

Cables
The cables are available with a variety of connection capabilities.

MC31XX Communication/Charge cables:

• Provide the mobile computer with operating and charging power when used with the Symbol approved power 
supply.

• Synchronize information between the mobile computer and a host computer. With customized or third party 
software, it can also synchronize the mobile computer with corporate databases.

• Provide serial connection through the serial pass-through port for communication with a serial device, such 
as a host computer. For communication setup procedures, refer to the MC31XX Series Mobile Computer 
Integrator Guide.

• Provide USB connection through the USB pass-through port for communication with a USB device, such as 
a host computer. For communication setup procedures, refer to the MC31XX Series Mobile Computer 
Integrator Guide. 

The following MC31XX Communication/Charge cables are available:

• Serial (RS232) Charge cable (9-pin D female with power input receptacle)

• USB Client Charge cable (standard-A connector and a barrel receptacle for power). 

Dedicated Printer cables, provide communication with a dedicated printer.

The following printer cables are available directly from the printer manufacturer:

• O’Neil printer cable

• Zebra printer cable

• Monarch printer cable.
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Figure 4-4    Cables

Battery Charging and Operating Power 

The MC31XX Communication/Charge cables can charge the mobile computer battery and supply operating power.

To charge the mobile computer battery:

1. Connect the MC31XX Communication/Charge cable power input connector to the Symbol approved power 
source.

2. Slide the bottom of the mobile computer into the MC31XX connector end of the MC31XX 
Communication/Charge cable and gently press in until the snaps latch into the mobile computer. 

3. The mobile computer amber Charge LED Indicator indicates the mobile computer battery charging status. The 
Standard Battery usually charges in less than five hours and the Extended Life Battery usually charges in less 
than eight hours. See, Table 4-2 on page 4-7 for charging status indications. 

4. When charging is complete, remove the cable by gently pulling the mobile computer and the cable apart until 
the snaps release the mobile computer. 

LED Charge Indications

The MC31XX Communication/Charge cables use the amber Charge LED Indicator to indicate the MC31XX battery 
charging status. See, Table 4-2 on page 4-7 for charging status indications. 

Snaps

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-2.
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Universal Battery Charger (UBC) Adapter 

The UBC Adapter can be used with a power supply as a standalone spare battery charger or it can be used with 
the four station UBC2000 to simultaneously charge up to four spare batteries. For additional information on the 
UBC 2000, refer to the UBC 2000 Quick Reference Guide p/n 70-33188-xx.

Spare Battery Charging

To charge spare batteries:

1. Insert the spare battery into the spare battery charging slot, bottom first.

2. Pivot the top of the battery down onto the contact pins.

Figure 4-5    UBC Adapter Battery Insertion

3. Gently press down on the battery to ensure proper contact. The Standard Battery usually charges in less than 
five hours and the Extended Life Battery usually charges in less than eight hours. See, Table 4-3 on page 4-14 
for charging status indications. 

4. When charging is complete, press the battery clip and lift the battery out of the slot.

UBC Adapter LED Charge Indications

The UBC Adapter charging LEDs indicate the battery charging status. The Standard Battery usually charges in less 
than five hours and the Extended Life Battery usually charges in less than eight hours. 

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 5-2.

UBC Adapter

Battery

Battery Clip

Spare Battery 
Charging Slot

2

1

WARNING! Do not use a tool to remove the battery.
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Figure 4-6    UBC Adapter LEDs

POWER

READY or STANDBY or FAULT

CHARGING

(Green) (Flashing Yellow) (Solid Yellow)

(Solid Yellow)

Table 4-3    UBC Adapter Charge LED Status Indications

LED Indication Description

POWER Green Power is connected to the UBC Adapter.

READY or Green Charging complete.

STANDBY 
or

Flashing-Yellow The battery was deeply discharged and is being trickle charged to bring the 
voltage up to the operating level. After operating level voltage is achieved, the 
battery charges normally.

FAULT Yellow Charging error, check placement of mobile computer/spare battery.

CHARGING Yellow Normal charge.
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Plastic Holster
The Plastic Holster provides a holder for the mobile computer. It consists of a mobile computer holder and a 
detachable belt clip. Press the release button to remove the detachable belt clip.

Figure 4-7    Plastic Holster 

Pinch the clip release and attach the Plastic Holster to a belt or waist band.

Figure 4-8    Attaching the Plastic Holster 

The Plastic Holster holds the mobile computer on a belt or waist band.

To insert the mobile computer, slide the mobile computer into the Plastic Holster with the screen facing the user.

To remove the mobile computer, press and lift to remove the mobile computer.

Detachable Belt Clip

Release Button

Mobile Computer Holder

Clip Release

Mobile Computer Holder
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Figure 4-9    Insert and Remove the Mobile Computer

Insert Mobile Computer Remove Mobile Computer
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Fabric Holster
The Fabric Holster provides a soft holder for the mobile computer. It consists of a fabric mobile computer holder, a 
detachable shoulder strap and a detachable belt clip. Press the release button to remove the detachable belt clip. 
See Figure 4-10 to remove the detachable clip see Figure 4-11 on page 4-17 to attach the Fabric Holster to a belt 
and see Figure 4-12 on page 4-18 to attach the Fabric Holster to a shoulder strap.

Figure 4-10    Fabric Holster Detachable Belt Clip

Belt Clip

Pinch the clip release and attach the Fabric Holster to a belt or waist band.

Figure 4-11    Attaching the Fabric Holster To a Belt

Detachable Belt Clip

Release Button

Mobile Computer Holder

Clip Release

Mobile Computer Holder
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Shoulder Strap

Remove the detachable belt clip (see Figure 4-10 on page 4-17) and attach the shoulder strap.

Figure 4-12    Attach the Fabric Holster To the Shoulder Strap

The Fabric Holster holds the mobile computer on a belt or waist band.

1. To insert the mobile computer, slide the mobile computer into the Fabric Holster with the screen facing the 
user.

2. Pull restraining strap over mobile computer and secure in the clip.

3. To remove the mobile computer, pull down on restraining strap to release from clip and lift retaining strap clear.

4. Lift mobile computer out of Fabric Holster.

Figure 4-13    Insert and Remove the Mobile Computer

Clip Release

Shoulder Strap



Chapter 5 Maintenance and Troubleshooting
Introduction
This chapter includes instructions on cleaning and storing the mobile computer, and provides troubleshooting 
solutions for potential problems during mobile computer operation.

Maintaining the Mobile Computer
For trouble-free service, observe the following tips when using the mobile computer:

For trouble-free service, observe the following tips when using the MC31XX:

• Do not scratch the screen of the MC31XX. When working with the MC31XX, use the supplied stylus or 
plastic-tipped pens intended for use with a touch-sensitive screen. Never use an actual pen or pencil or other 
sharp object on the surface of the MC31XX screen. 

Motorola recommends using a screen protector, p/n KT-122010-01R.

• The touch-sensitive screen of the MC31XX is glass. Do not to drop the MC31XX or subject it to strong 
impact.

• Protect the MC31XX from temperature extremes. Do not leave it on the dashboard of a car on a hot day, and 
keep it away from heat sources.

• Do not store or use the MC31XX in any location that is dusty, damp, or wet.

• Use a soft lens cloth to clean the MC31XX. If the surface of the MC31XX screen becomes soiled, clean it 
with a soft cloth moistened with a diluted window-cleaning solution.

• Periodically replace the rechargeable battery to ensure maximum battery life and product performance. 
Battery life depends on individual usage patterns.
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• A screen protector is applied to the MC31XX. Motorola recommends using this to minimize wear and tear. 
Screen protectors enhance the usability and durability of touch screen displays. Benefits include:

• Protection from scratches and gouges

• Durable writing and touch surface with tactile feel

• Abrasion and chemical resistance

• Glare reduction

• Keeping the device’s screen looking new

• Quick and easy installation.

Battery Safety Guidelines

• The area in which the units are charged should be clear of debris and combustible materials or chemicals. 
Particular care should be taken where the device is charged in a non commercial environment.

• Follow battery usage, storage, and charging guidelines found in the user's guide.

• Improper battery use may result in a fire, explosion, or other hazard.

• Do not use a tool to remove the battery from the mobile computer or battery charging accessory.

• To charge the mobile device battery, the battery and charger temperatures must be between +32 ºF and 
+104 ºF (0 ºC and +40 ºC)

• Do not use incompatible batteries and chargers. Use of an incompatible battery or charger may present a risk 
of fire, explosion, leakage, or other hazard. If you have any questions about the compatibility of a battery or a 
charger, contact Motorola Enterprise Mobility support.

• For devices that utilize a USB port as a charging source, the device shall only be connected to products that 
bear the USB-IF logo or have completed the USB-IF compliance program.

• To enable authentication of an approved battery, as required by IEEE1725 clause 10.2.1, all batteries will 
carry a Motorola hologram. Do not fit any battery without checking it has the Motorola authentication 
hologram.

• Do not disassemble or open, crush, bend or deform, puncture, or shred.

• Severe impact from dropping any battery-operated device on a hard surface could cause the battery to 
overheat.

• Do not short circuit a battery or allow metallic or conductive objects to contact the battery terminals.

• Do not modify or remanufacture, attempt to insert foreign objects into the battery, immerse or expose to water 
or other liquids, or expose to fire, explosion, or other hazard.

• Do not leave or store the equipment in or near areas that might get very hot, such as in a parked vehicle or 
near a radiator or other heat source. Do not place battery into a microwave oven or dryer.

• Battery usage by children should be supervised.

• Please follow local regulations to properly dispose of used re-chargeable batteries.

• Do not dispose of batteries in fire.

WARNING! Failure to follow these guidelines may result in fire, explosion, or other hazard.
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• In the event of a battery leak, do not allow the liquid to come in contact with the skin or eyes. If contact has 
been made, wash the affected area with large amounts of water and seek medical advice.

• If you suspect damage to your equipment or battery, contact Motorola Enterprise Mobility support to arrange 
for inspection.

Cleaning

Materials Required

• Alcohol wipes

• Lens tissue

• Cotton tipped applicators

• Isopropyl alcohol

• Can of compressed air with a tube.

Cleaning the MC31XX

Housing

Using the alcohol wipes, wipe the housing including keys and in-between keys.

Display

The display can be wiped down with the alcohol wipes, but care should be taken not to allow any pooling of liquid 
around the edges of the display. Immediately dry the display with a soft, non-abrasive cloth to prevent streaking.

Scanner Exit Window

Wipe the scanner exit window periodically with a lens tissue or other material suitable for cleaning optical material 
such as eyeglasses.

Connector

1. Remove the main battery from mobile computer. See Main Battery Removal on page 1-11.

2. Dip the cotton portion of the cotton tipped applicator in isopropyl alcohol.

3. Rub the cotton portion of the cotton tipped applicator back-and-forth across the connector on the bottom of the 
MC31XX. Do not leave any cotton residue on the connector.

CAUTION Always wear eye protection.

Read warning label on compressed air and alcohol product before using.

If you have to use any other solution for medical reasons please contact Motorola for more information.

WARNING! Avoid exposing this product to contact with hot oil or other flammable liquids. If such exposure 
occurs, unplug the device and clean the product immediately in accordance with these guidelines.
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4. Repeat at least three times.

5. Use the cotton tipped applicator dipped in alcohol to remove any grease and dirt near the connector area.

6. Use a dry cotton tipped applicator and repeat steps 4 through 6.

7. Spray compressed air on the connector area by pointing the tube/nozzle about ½ inch away from the surface. 
CAUTION: Do not point nozzle at yourself and others, ensure the nozzle or tube is away from your face.

8. Inspect the area for any grease or dirt, repeat if required.

Cleaning Cradle Connectors

To clean the connectors on a cradle:

1. Remove the DC power cable from the cradle.

2. Dip the cotton portion of the cotton tipped applicator in isopropyl alcohol.

3. Rub the cotton portion of the cotton tipped applicator along the pins of the connector. Slowly move the 
applicator back-and-forth from one side of the connector to the other. Do not let any cotton residue on the 
connector.

4. All sides of the connector should also be rubbed with the cotton tipped applicator.

5. Spray compressed air in the connector area by pointing the tube/nozzle about ½ inch away from the surface. 
CAUTION: do not point nozzle at yourself and others, ensure the nozzle or tube is pointed away from your 
face.

6. Ensure that there is no lint left by the cotton tipped applicator, remove lint if found.

7. If grease and other dirt can be found on other areas of the cradle, use lint free cloth and alcohol to remove.

8. Allow at least 10 to 30 minutes (depending on ambient temperature and humidity) for the alcohol to air dry 
before applying power to cradle.

If the temperature is low and humidity is high, longer drying time is required. Warm temperature and dry 
humidity requires less drying time.

Cleaning Frequency

The cleaning frequency is up to the customer’s discretion due to the varied environments in which the mobile 
devices are used. They may be cleaned as frequently as required. However when used in dirty environments it 
may be advisable to periodically clean the scanner exit window to ensure optimum scanning performance.



Maintenance and Troubleshooting 5 - 5
Troubleshooting

Mobile Computer

Table 5-1    Troubleshooting the Mobile Computer

Problem Cause Solution

Mobile computer does 
not turn on.

Main battery not 
charged.

Charge or replace the main battery.

Main battery not 
installed properly.

Ensure the battery is installed properly. See Install Main Battery 
on page 1-6.

System crash. Perform a warm boot. If the mobile computer still does not turn 
on, perform a cold boot. For more information see, Resetting the 
Mobile Computer on page 2-23.

Battery did not charge. Battery failed. Replace battery. If the mobile computer still does not operate, try 
a warm boot, then a cold boot. For more information see, 
Resetting the Mobile Computer on page 2-23.

Mobile computer 
removed from cradle 
while battery was 
charging. 

Insert mobile computer in cradle and begin charging. The 
Standard Battery requires up to five hours to recharge fully and 
the Extended Life Battery requires up to eight hours to recharge 
fully.

Extreme battery 
temperature.

Battery does not charge if ambient temperature is below 32°F 
(0°C) or above 104°F (40°C).

Cannot see characters 
on screen.

Mobile computer not 
powered on.

Press the Power button.

During data 
communication, no data 
was transmitted, or 
transmitted data was 
incomplete.

Mobile computer 
removed from cradle 
or unplugged from 
host computer during 
communication.

Replace the mobile computer in the cradle, or reattach the cable 
and re-transmit.

Incorrect cable 
configuration.

See the system administrator or refer to the MC31XX Series 
Mobile Computer Integrator Guide.

Communication 
software was 
incorrectly installed or 
configured.

See the system administrator or refer to the MC31XX Series 
Mobile Computer Integrator Guide.

Mobile computer does 
not emit sound.

Volume setting is low 
or turned off.

Click on the speaker icon to increase the volume.
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Mobile computer turns 
itself off.

Mobile computer is 
inactive.

The mobile computer turns off after a period of inactivity. This 
period can be set from one to five minutes, in one-minute 
intervals.

Battery is depleted. Recharge or replace the battery.

Battery is not inserted 
properly.

Insert the battery properly. For more information see, Install Main 
Battery on page 1-6.

Tapping the window 
buttons or icons does 
not activate the 
corresponding feature.

Touch screen not 
calibrated correctly.

Re-calibrate the screen. 
From the mobile computer, Demo window double-tap the Ctl 
Panel icon and double-tap on Touch Calibrate. Follow the screen 
prompts.

The system crashed. Warm boot the system. To perform a warm boot, see Resetting 
the Mobile Computer on page 2-23.

A message appears 
stating that the mobile 
computer memory is 
full.

Too many files stored 
on the mobile 
computer.

Delete unused memos and records. If necessary, save these 
records on the host computer.

Too many 
applications installed 
on the mobile 
computer.

Remove unused installed applications from the mobile computer 
to recover memory. 

The mobile computer 
does not accept scan 
input.

Scanning application 
is not loaded.

Verify that the mobile computer is loaded with a scanning 
application. See the system administrator.

Unreadable bar code. Ensure the symbol is not defaced.

Distance between 
scan window and bar 
code is incorrect.

Ensure the mobile computer is within proper scanning range.

Mobile computer is 
not programmed for 
the bar code type.

Ensure the mobile computer is programmed to accept the type of 
bar code scanned. 

Mobile computer is 
not programmed to 
generate a beep.

If a beep on a good decode is expected and a beep is not heard, 
check that the application is set to generate a beep on good 
decode.

Battery is low. Check the battery level. When the battery is low, the mobile 
computer automatically goes into suspend mode.

Table 5-1    Troubleshooting the Mobile Computer (Continued)

Problem Cause Solution
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Single Slot Serial/USB Cradle

Table 5-2    Troubleshooting the Single Slot Serial/USB Cradle

Symptom Possible Cause Solution

Mobile computer 
amber Charge LED 
Indicator does not light 
when mobile computer 
inserted.

Cradle is not receiving power. Ensure the power cable is connected securely to both 
the cradle and to AC power.

Mobile computer is not 
correctly seated.

Remove and re-insert the mobile computer into the 
cradle, ensuring it is correctly seated.

Spare Battery Charging 
LED does not light 
when spare battery is 
inserted.

Spare battery is not correctly 
seated.

Remove and re-insert the spare battery into the charging 
slot, ensuring it is correctly seated.

Mobile computer 
battery is not charging.

Mobile computer was 
removed from cradle or cradle 
was unplugged from AC 
power too soon.

Ensure cradle is receiving power. Ensure the mobile 
computer is seated correctly. If the mobile computer 
battery is fully depleted, it can take up to five hours to 
fully recharge a Standard Battery and it can take up to 
eight hours to fully recharge an Extended Life Battery.

Battery is faulty. Verify that other batteries charge properly. If so, replace 
the faulty battery.

The mobile computer is not 
fully seated in the cradle.

Remove and re-insert the mobile computer into the 
cradle, ensuring it is correctly seated. 

Spare battery is not 
charging.

Battery not fully seated in 
charging slot. 

Remove and re-insert the spare battery into the cradle, 
ensuring it is correctly seated.

Battery inserted incorrectly. Ensure the contacts are facing down and toward the 
back of the cradle.

Battery is faulty. Verify that other batteries charge properly. If so, replace 
the faulty battery.

During data 
communication, no 
data was transmitted, 
or transmitted data was 
incomplete.

Mobile computer removed 
from cradle during 
communication.

Replace mobile computer in cradle and retransmit.

Incorrect cable configuration. See the system administrator or refer to the MC31XX 
Series Mobile Computer Integrator Guide.

Communication software is 
not installed or configured 
properly.

See the system administrator or refer to the MC31XX 
Series Mobile Computer Integrator Guide.
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Four Slot Charge Only Cradle

Four Slot Ethernet Cradle

Table 5-3    Troubleshooting the Four Slot Charge Only Cradle

Problem Cause Solution

Mobile computer amber 
Charge LED Indicator does 
not light when mobile 
computer inserted.

Cradle is not receiving power. Ensure the power cable is connected securely to 
both the cradle and to AC power.

Mobile computer is not 
correctly seated.

Remove and re-insert the mobile computer into the 
cradle, ensuring it is correctly seated. 

Mobile computer battery is 
not charging.

Mobile computer was 
removed from cradle or cradle 
was unplugged from AC 
power too soon.

Ensure cradle is receiving power. Ensure the 
mobile computer is seated correctly. If the mobile 
computer battery is fully depleted, it can take up to 
five hours to fully recharge a Standard Battery and it 
can take up to eight hours to fully recharge an 
Extended Life Battery.

Battery is faulty. Verify that other batteries charge properly. If so, 
replace the faulty battery.

The mobile computer is not 
fully seated in the cradle.

Remove and re-insert the mobile computer into the 
cradle, ensuring it is correctly seated. 

Table 5-4    Troubleshooting the Four Slot Ethernet Cradle

Problem Cause Solution

Mobile computer amber 
Charge LED Indicator does 
not light when mobile 
computer inserted.

Cradle is not receiving power. Ensure the power cable is connected securely to 
both the cradle and to AC power.

Mobile computer is not 
correctly seated.

Remove and re-insert the mobile computer into 
the cradle, ensuring it is correctly seated. 

Mobile computer battery is 
not charging.

Mobile computer was removed 
from cradle or cradle was 
unplugged from AC power too 
soon.

Ensure cradle is receiving power. Ensure the 
mobile computer is seated correctly. If the mobile 
computer battery is fully depleted, it can take up 
to five hours to fully recharge a Standard Battery 
and it can take up to eight hours to fully recharge 
an Extended Life Battery.

Battery is faulty. Verify that other batteries charge properly. If so, 
replace the faulty battery.

The mobile computer is not 
fully seated in the cradle.

Remove and re-insert the mobile computer into 
the cradle, ensuring it is correctly seated. 
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Four Slot Spare Battery Charger

During data communication, 
no data was transmitted, or 
transmitted data was 
incomplete.

Mobile computer removed from 
cradle during communication.

Replace mobile computer in cradle and 
retransmit.

Incorrect cable configuration. See the system administrator or refer to the 
MC31XX Series Mobile Computer Integrator 
Guide.

Ethernet connection error. Link 
LED is not lit (see Link LED on 
page 4-9). 

See the system administrator. Probable Ethernet 
connection error.

Table 5-4    Troubleshooting the Four Slot Ethernet Cradle (Continued)

Problem Cause Solution

Table 5-5    Troubleshooting the Four Slot Spare Battery Charger

Symptom Possible Cause Solution

Spare Battery 
Charging LED does 
not light when 
spare battery is 
inserted.

Spare battery is not 
correctly seated.

Remove and re-insert the spare battery into the charging slot, 
ensuring it is correctly seated.

Spare battery is not 
charging.

Charger is not 
receiving power.

Ensure the power cable is connected securely to both the charger 
and to AC power.

Spare battery is not 
correctly seated.

Remove and re-insert the battery into the charger, ensuring it is 
correctly seated. 

Spare battery was 
removed from charger 
or charger was 
unplugged from AC 
power too soon.

Ensure charger is receiving power. Ensure the spare battery is 
seated correctly. If a battery is fully depleted, it can take up to five 
hours to fully recharge a Standard Battery and it can take up to eight 
hours to fully recharge an Extended Life Battery.

Spare battery is faulty. Verify that other batteries charge properly. If so, replace the faulty 
battery.
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UBC Adapter

Cables

Table 5-6    Troubleshooting the UBC Adapter

Symptom Possible Cause Solution

Battery Charging 
LED does not light 
when spare battery 
is inserted.

Spare battery is not 
correctly seated.

Remove and re-insert the spare battery into the charging slot, 
ensuring it is correctly seated. 

Battery not charging. Charger is not receiving 
power.

Ensure the power cable is connected securely to both the charger 
and to AC power.

Spare battery is not 
correctly seated.

Remove and re-insert the spare battery into the charger, ensuring 
it is correctly seated. 

Spare battery was 
removed from charger 
or charger was 
unplugged from AC 
power too soon.

Ensure charger is receiving power. Ensure the spare battery is 
seated correctly. If a battery is fully depleted, it can take up to five 
hours to fully recharge a Standard Battery and it can take up to 
eight hours to fully recharge an Extended Life Battery.

Spare battery is faulty. Verify that other batteries charge properly. If so, replace the faulty 
battery.

Table 5-7    Troubleshooting the Cables

Symptom Possible Cause Solution

Mobile computer 
amber Charge LED 
Indicator does not 
light when mobile 
computer attached.

Cable is not receiving 
power.

Ensure the power cable is connected securely to both the cable 
and to AC power.

Mobile computer is not 
seated correctly in the 
cable.

Remove and re-attach the mobile computer to the MC31XX 
connector, ensuring it is correctly seated. 

Mobile computer 
battery is not 
charging.

Mobile computer was 
detached from cable or 
cable was unplugged 
from AC power too 
soon.

Ensure cable is receiving power. Ensure the mobile computer is 
seated correctly. If the mobile computer battery is fully depleted, it 
can take up to five hours to fully recharge a Standard Battery and 
it can take up to eight hours to fully recharge an Extended Life 
Battery.

Battery is faulty. Verify that other batteries charge properly. If so, replace the faulty 
battery.

The mobile computer is 
not fully seated in the 
cable.

Remove and re-attach the mobile computer to the cable, ensuring 
it is correctly seated. 
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During data 
communication, no 
data was 
transmitted, or 
transmitted data was 
incomplete.

Cable removed from 
mobile computer during 
communication.

Reattach cable to mobile computer and retransmit.

Incorrect cable 
configuration.

See the system administrator or refer to the MC31XX Series 
Mobile Computer Integrator Guide.

Communication 
software is not installed 
or configured properly.

See the system administrator or refer to the MC31XX Series 
Mobile Computer Integrator Guide.

Table 5-7    Troubleshooting the Cables (Continued)

Symptom Possible Cause Solution
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Appendix A  Technical Specifications
Mobile Computer and Accessory Technical Specifications
Table A-1 summarizes the mobile computer technical specifications and intended operating environments. 

Table A-2 summarizes the accessory technical specifications and the intended operating environments.

Table A-1    MC31XX Technical Specifications

Item Description

Physical Characteristics

Dimensions MC31XXS:
7.49 in L x 3.25 in W x 1.77 in D
(190.4 mm L x 82.6 mm W x 45.2 mm D)
At grip: 2.40 in. W x 1.44 in. D/61.2 mm x 36.8 mm

MC31XXR:
8.55 in L x 3.25 in W x 1.57 in D
(217.12 mm L x 82.6 mm W x 39.9 mm D)
At grip: 2.40 in. W x 1.14 in. D/61.2 mm x 29 mm

MC3190G:
7.5 in L x 3.2 in W x 6.5 in D
(193 mm L x 80.8 mm W x 166 mm H)

Weight (including battery, stylus, 
and handstrap)

MC31XXR (with standard battery)* - 13.52 oz (384 g)
MC31XXS (with extended battery)* - 14.95 oz (424 g)
MC3190G (with extended battery)* - 18.34 oz (520 g)

Display 3.0 inch Color (TFT) (320 x 320) display with backlight

Touch Panel Analog resistive touch

Backlight LED backlight
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Battery Standard: Rechargeable Lithium-Ion 2740 mAh minimum (3.7V)
Extended Life: Rechargeable Lithium-Ion 4800 mAh minimum (3.7V)

Expansion Slot User accessible SD/MMC slot up to 8 GB; approved for memory expansion only

Network Connections High-speed USB client, full-speed USB host, Bluetooth and WiFi.
USB host mode available with appropriate cables only.

Notification Programmable LEDs; Audio notifications

Keypad Options 28-key Numeric
38-key Shifted Alpha (calculator-style integrated numeric keypad)
48-key Alpha-Numeric (calculator-style integrated numeric keypad)

Audio Speaker, receiver, microphone, software support for full duplex capability, 
Bluetooth stereo.

Performance Characteristics

CPU Marvell PXA320 processor at 624 MHz

Operating System Microsoft® Windows CE .NET 6.0 Professional

Microsoft® Windows Mobile 6.1 or 6.5 Classic

Memory 128 MB RAM/256 MB Flash,
128 MB RAM/512 MB Flash, 
256 MB RAM/512 MB Flash or
256 MB RAM/1 GB Flash

Output Power USB: 5 VDC @ 400 mA max.

User Environment

Operating Temperature  -20°C to 50°C (-4°F to 122°F)

Storage Temperature -40° to 70°C (-40° to 158°F) without battery

Charging Temperature 0° C to 40° C (32°F to 104°F)

Humidity 5 - 95% non-condensing

Drop Specification Multiple 4 ft./1.2 m drop to concrete across the operating temperature range
Meets and exceeds MIL-STD 810G drop specifications.

Tumble 500 1.64 ft./0.5 m tumbles (1,000 drops) at room temperature per IEC 68-2-32 
tumble specification.

Electrostatic Discharge (ESD) +/-15 kV air discharge 
+/- 8 kV direct discharge 
+/- 8 kV indirect discharge 

Sealing IP54 category 2; meets applicable EN 60529 sealing specifications.

Table A-1    MC31XX Technical Specifications (Continued)

Item Description
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Wireless LAN Data and Voice Communications

Wireless Local Area Network 
(WLAN) radio

Tri-mode IEEE® 802.11a/b/g

Data Rates Supported 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, and 54 Mbps

Operating Channels Chan 1-13 (2412-2472 MHz), Chan 14 (2484 MHz) Japan only; actual 
operating channels/frequencies depend on regulatory rules and certification 
agency

Security WPA2 (Personal or Enterprise); 802.1x; EAP-TLS; TTLS (CHAP,
MS-CHAP, MS-CHAPv2, PAP or MD5); PEAP (TLS, MSCHAPv2,
EAP-GTC); LEAP, EAP-FAST (TLS, MS-CHAPv2,
EAP-GTC); CCXv4 certified; support for IPv6; FIPS140-2 Certified

Spreading Technique Direct Sequence Spread Spectrum (DSSS) and Orthogonal Frequency Division 
Multiplexing (OFDM)

Antenna Internal antenna w/diversity

Voice Communication Voice-over-IP ready, Wi-Fi™-certified, IEEE 802.11a/b/g direct sequence 
wireless LAN, Wi-Fi Multimedia™ (WMM), Motorola Voice Quality Manager 
(VQM)

Wireless PAN Data and Voice Communications

Bluetooth Class II, v2.1 with Enhanced Data Rate (EDR); integrated antenna

Regulatory

Electrical Safety Certified to UL60950-1, CSA C22.2 No. 60950-1, EN60950/IEC 60950-1

Environmental RoHS-compliant

WLAN and Bluetooth (PAN) USA: FCC Part 15.247, 15.407
Canada: RSS-210
EU: EN 300 328, EN 301 893
Japan: ARIB STD T33, T66, T70, T71
Australia: AS/NZS 4268s

RF Exposure USA: FCC Part 2, FCC OET Bulletin 65 Supplement C
Canada: RSS-102
EU: EN 62311
Australia: Radio communications Standard 2003

EMI/RFI Radio Version USA: FCC Part 15
Canada: RSS210 Class B
EU: EN 301 489-1, 489-17

Table A-1    MC31XX Technical Specifications (Continued)

Item Description
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EMI/RFI Batch Version USA: FCC Part 15
Canada: ICES 003 Class B
EU: EN55022 Class B EN55024 
Japan: CISPR 22, Class B
Australia: AS3548

Laser Safety IEC Class2/FDA Class II in accordance with IEC60825-1/EN60825-1

Data Capture Specifications

Options 1D laser scanner
2D imager

Laser 1D Scanner (SE950) Specifications

Range on 100% UPCA Near: 3.8 cm (1.5 in.) Far: 60 cm (24 in.)

Optical Resolution 0.004 in. minimum element width

Roll +/- 35° from vertical

Pitch Angle +/- 65° from normal

Skew Tolerance +/- 50° from normal

Ambient Light 10,000 ft. candles/107,640 lux

Scan Rate 104 (+/- 12) scans/sec (bidirectional)

Scan Angle 47° ± 3° default; configurable narrow angle: 35° ± 3°

2D Imager Engine (SE4500-SR) Specifications

Range on 100% UPCA at 
30 ft./candles

Near: 6.35 cm (2.5 in.) Far: 36.07 cm (14.2 in.)

Field of View Horizontal - 38°
Vertical - 25°

Optical Resolution 752 x 480 pixels

Roll 360°

Pitch Angle +/- 60° from normal

Skew Tolerance +/- 60° from normal

Ambient Light 9,000 ft. candles (96,900 Lux)

Focal Distance from Front of 
Engine

Near: 4 cm (1.6 in.)
Far: 38 cm (15 in.)

Aiming Element (VLD) 655 nm +/- 10 nm

Illumination Element (LED) 625 nm +/- 5 nm

Table A-1    MC31XX Technical Specifications (Continued)

Item Description
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2D Imager Engine (SE4500-HD) Specifications

Range on 100% UPCA at 
30 ft./candles

Near: 6.65 cm (2.62 in.) Far: 15.49 cm (6.1 in.)

Field of View Horizontal - 39°
Vertical - 25°

Optical Resolution 752 x 480 pixels

Roll 360°

Pitch Angle +/- 60° from normal

Skew Tolerance +/- 60° from normal

Ambient Light 9,000 ft. candles (96,900 Lux)

Focal Distance from Front of 
Engine

Near: 4 cm (1.6 in.)
Far: 17 cm (6.8 in.)

Aiming Element (VLD) 655 nm +/- 10 nm

Illumination Element (LED) 625 nm +/- 5 nm

Motorola Interactive Sensor Technology

Motion-sensor 3-axis accelerometer that enables motion-sensing applications on dynamic 
screen orientation, power management and free-fall detects

Table A-2    Accessory Specifications

Single Slot 
Serial/USB 

Cradle
Cables

Four Slot Charge 
Only and 

Ethernet Cradles

Four Slot 
Spare Battery 

Charger

Universal 
Battery Charger 
(UBC) Adapter

Operating 
Temperature

32° to 122°F (0° to +50°C) 32° to 104°F (0° to +40°C)

Storage Temperature -40° to 158°F (-40° to 70°C)

Battery Charging 
Temperature

32° to 104° F (0° to +40° C) ambient temperature

Humidity 5% to 95% non-condensing

Size (L x D x H) 4.4 in x 5.7 in x 4.7 
in
(11.2 cm x 14.5 
cm x 12 cm)

6 feet
(1.83 
m)

18 in x 4 in x 5 in
(45.7 cm x 10.1 cm 
x 12 cm)

8.25 in x 6.0 in x 
1.7 in (20.96 cm 
x 15.24 cm x 
4.32 cm)

2.5 in x 6.1 in x 1.5 
in
(6.4 cm x 15.5 cm x 
3.8 cm)

Table A-1    MC31XX Technical Specifications (Continued)

Item Description
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Weight 0.60 lbs (0.27 kg) N/A Charge only:
2.25 lbs (1.02 kg)
Ethernet:
2.38 lbs (1.08 kg)

13.6 oz (386 g) 0.25 lbs (0.11 kg)

Power 12V, 3.3 A 5.4V, 3 
A

12V, 9 A 12V, 3.3 A 15V, 1.5 A

Drop 30 inches (76.2 centimeter) to vinyl covered concrete

Electrostatic 
Discharge (ESD)

+/-15 kV air discharge, +/- 8 kV direct discharge, +/- 8 kV indirect discharge 

Table A-2    Accessory Specifications (Continued)

Single Slot 
Serial/USB 

Cradle
Cables

Four Slot Charge 
Only and 

Ethernet Cradles

Four Slot 
Spare Battery 

Charger

Universal 
Battery Charger 
(UBC) Adapter



Appendix B  Keypads
Introduction
The mobile computer is available with the following keypad configurations:

• 28-key keypad

• 38-key keypad 

• 48-key keypad.

NOTE For information about using the soft keyboard input panel. For more information, see Entering Information 
Using the Keyboard Input Panel on page 2-15.
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28-Key Keypad

The 28-key keypad contains a Power button, application keys, scroll keys and function keys. The keypad is 
color-coded to indicate the alternate function key (blue) values and the alternate ALPHA key (orange) values. Note 
that keypad functions can be changed by an application so the mobile computer keypad may not function as 
described. See Table B-1 on page B-2 for key and button descriptions and Table B-2 on page B-4 for the keypad 
alternate functions.

Figure B-1    28-Key Keypad

Table B-1    28-Key Descriptions

Key Description

Power (red) Powers the mobile computer screen on and off (resume and suspend).

Green Circle Programmable application function key by default. 

Red Circle Programmable application function key by default. 

Scan (yellow) Used in scanning applications, press to scan a bar code. This key has the same 
function as activating the side mounted scan buttons.
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Scroll Up and Down Moves up and down from one item to another. Increases/decreases specified 
values.
Increases and decreases volume when the blue FUNC key is activated and the up 
and down arrow keys are pressed.

Scroll Left and Right Moves left and right from one item to another. Increases/decreases specified values.
Produces a TAB when the blue FUNC key is activated and the right arrow key is 
pressed.

ESC Produces the ESC function by default. 

CTRL Press and release the CTRL key to activate the keypad alternate CTRL functions. 

The  icon appears on the taskbar on WinCE devices or the  icon appears at 
the bottom of the screen on Windows Mobile 6.1 devices. Press and release the 
CTRL key again to return to the default keypad functions.
Press and release the blue FUNC key and then the CTRL key to activate the ALT 

functions. The  icon appears on the taskbar on WinCE devices or the  icon 
appears at the bottom of the screen on Windows Mobile 6.1 devices. Press and 
release the CTRL key two times to return to the default keypad functions.

Numeric/Alpha/Special 
Function

Numeric, alpha or special function keys. Numeric by default.
Produces a special function when the blue FUNC key is activated.
Produces alpha values when the orange ALPHA key is activated.
In Alpha state, produces the lower case alphabetic characters on the key. Each key 
press produces the next alphabetic character in sequence. For example, press and 
release the ALPHA key and then press the 4 key once to produce the letter ‘g’; press 
and release the ALPHA key and then press the 4 key three times to produce the 
letter ‘i’.
When the SHIFT key is pressed in Alpha state, the upper case alphabetic characters 
on the key are produced. For example, press and release the ALPHA key, press and 
hold the SHIFT key and then press the 4 key once to produce the letter ‘G’; press 
and release the ALPHA key, press and hold the SHIFT key and then press the 4 key 
three times to produce the letter ‘I’.

Period/Decimal Point Produces a period for alpha entries and a decimal point for numeric entries by 
default.
Increases brightness when the blue FUNC key is activated.

Enter Executes a selected item or function.

BKSP Backspace function by default.
Decreases brightness when the blue FUNC key is activated.

Table B-1    28-Key Descriptions (Continued)

Key Description

ALT ALT
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SPACE Space function by default.

Shift Press and release the SHIFT key to activate the keypad alternate SHIFT functions. 

The  icon appears on the taskbar on WinCE devices and the  icon appears at 
the bottom of the screen on Windows Mobile 6.1 devices. Press and release the 
SHIFT key again to return to the default keypad functions.

ALPHA (orange) Press the orange ALPHA key to access the alternate ALPHA characters (shown on 

the keypad in orange). The  icon appears on the taskbar on WinCE devices and 

the  icon appears at the bottom of the screen on Windows Mobile 6.1 devices. 
Press and release the orange ALPHA key again to return to the default keypad 
functions.

FUNC (blue) Press and release the blue FUNC key to activate the keypad alternate functions 
(shown on the keypad in blue). The  icon appears on the taskbar on WinCE 

devices or the  icon appears at the bottom of the screen on Windows Mobile 6.1 
devices. Press and release the blue FUNC key again to return to the default keypad 
functions.

Display backlight Toggles the display backlight on and off.

Table B-2    28-key Keypad Input Modes

Key
Numeric Mode Orange Key

(Alpha Lowercase Mode)
Orange + Shift Keys

(Alpha Uppercase Mode)

SHIFT 
+ Key

1st 
Press

2nd 
Press

3rd 
Press

4th 
Press

1st 
Press

2nd 
Press

3rd 
Press

4th 
Press

1 1 ! * *

2 2 @ a b c A B C

3 3 # d e f D E F

4 4 $ g h i G H I

5 5 % j k l J K L

6 6 ^ m n o M N O

7 7 & p q r s P Q R S

8 8 * t u v T U V

Note: An application can change the key functions. The keypad may not function exactly as described.

Table B-1    28-Key Descriptions (Continued)

Key Description
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9 9 ( w x y z W X Y Z

0 0 ) 0 0

. . > . .

Table B-2    28-key Keypad Input Modes (Continued)

Key
Numeric Mode Orange Key

(Alpha Lowercase Mode)
Orange + Shift Keys

(Alpha Uppercase Mode)

SHIFT 
+ Key

1st 
Press

2nd 
Press

3rd 
Press

4th 
Press

1st 
Press

2nd 
Press

3rd 
Press

4th 
Press

Note: An application can change the key functions. The keypad may not function exactly as described.
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38-Key Keypad

The 38-key keypad contains a Power button, application keys, scroll keys and function keys. The keypad is 
color-coded to indicate the alternate function key (blue) values. Note that keypad functions can be changed by an 
application so the mobile computer keypad may not function as described. See Table B-3 on page B-6 for key and 
button descriptions and Table B-4 on page B-8 for the keypad alternate functions. 

Figure B-2    38-Key Keypad

Table B-3    38-Key Descriptions

Key Description

Power (red) Powers the mobile computer screen on and off (resume and suspend).

Green Circle Programmable application function key by default.

Red Circle Programmable application function key.
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Scan (yellow) Used in scanning applications, press to scan a bar code.

Scroll Left and Right Moves left and right from one item to another by default. 
Produces a TAB when the blue FUNC key is activated and the right arrow key is 
pressed.

Scroll Up and Down Moves up and down from one item to another by default. 

ALPHA (orange) Press the orange ALPHA key to access the alternate ALPHA characters (shown on the 

keypad in orange). The  icon appears on the taskbar on WinCE devices and the  
icon appears at the bottom of the screen on Windows Mobile 6.1 devices. Press and 
release the orange ALPHA key again to return to the default keypad functions.

CTRL Press and release the CTRL key to activate the keypad alternate CTRL functions. The 

 icon appears on the taskbar on WinCE devices or the  icon appears at the 
bottom of the screen on Windows Mobile 6.1 devices. Press and release the CTRL key 
again to return to the default keypad functions.
Press and release the blue FUNC key and then the CTRL key to activate the ALT 

functions. The  icon appears on the taskbar on WinCE devices or the  icon 
appears at the bottom of the screen on Windows Mobile 6.1 devices. Press and release 
the CTRL key two times to return to the default keypad functions.

ESC Produces the escape function.

FUNC (blue) Press and release the blue FUNC key to activate the keypad alternate functions (shown 
on the keypad in blue). The  icon appears on the taskbar on WinCE devices or the 

 icon appears at the bottom of the screen on Windows Mobile 6.1 devices. Press and 
release the blue FUNC key again to return to the default keypad functions.

Numeric/Alpha/Special 
Function

Press for the default numeric value.
Produces alpha values when the orange ALPHA key is activated.

BKSP Backspace function by default.
Produces the Space function when the orange ALPHA key is activated.

SHIFT Press and release the SHIFT key to activate the keypad alternate SHIFT functions. The 

 icon appears on the taskbar on WinCE devices and the  icon appears at the 
bottom of the screen on Windows Mobile 6.1 devices. Press and release the SHIFT key 
again to return to the default keypad functions.

Table B-3    38-Key Descriptions (Continued)

Key Description

ALT ALT

. . .
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Enter Executes a selected item or function.

Period Produces a period for alpha entries and a decimal point for numeric entries.

Comma Produces a comma by default.

Special Function/Alpha Special function by default or when the blue FUNC key is activated.

Display backlight Toggles the display backlight on and off.

Table B-4    38-key Keypad Input Modes

Key Normal SHIFT + Key Orange + Key Orange + Shift 
+ Key Blue + Key

Right Arrow a A

Up Arrow b B

Down Arrow c C

Left Arrow d D Tab

CTRL e E Ctrl

ESC f F

7 7 & g G -

8 8 * h H =

9 9 ( i I /

BKSP Backspace Backspace Space Space Backspace

4 4 $ j J [

5 5 % k K ]

6 6 ^ l L ;

Note: An application can change the key functions. The keypad may not function exactly as described.

Table B-3    38-Key Descriptions (Continued)

Key Description

. . .



Keypads B - 9
1 1 ! m M ‘

2 2 @ n N ‘

3 3 # o O \

, , < p P ,

0 0 ) q Q 0

. . > r R .

F1 s S F11

F2 t T F12

F3 u U F13

F4 v V F14

F5 w W

F6 x X Increase Brightness

F7 y Y Increase Volume

F8 z Z

F9 Decrease Brightness

F10 * Decrease Volume

Table B-4    38-key Keypad Input Modes (Continued)

Key Normal SHIFT + Key Orange + Key Orange + Shift 
+ Key Blue + Key

Note: An application can change the key functions. The keypad may not function exactly as described.
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48-Key Keypad

The 48-key keypad contains a Power button, application keys, scroll keys and function keys. The keypad is 
color-coded to indicate the alternate function key (blue) values. Note, that keypad functions can be changed by an 
application so the mobile computer keypad may not function as described. See Table B-5 on page B-10 for key and 
button descriptions and Table B-6 on page B-12 for the keypad special functions.

Figure B-3    48-Key Keypad

Table B-5    48-Key Descriptions

Key Description

Power (red) Powers the mobile computer screen on and off (resume and suspend).

Green Circle Unassigned application function key by default.

Red Circle Unassigned application function key.

Scan (yellow) Scan key, used for scanning applications.
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Orange Press the orange key to access the alternate navigation and selection functions. The  

icon appears on the taskbar on WinCE devices and the  icon appears at the bottom of 
the screen on Windows Mobile 6.1 devices. Press and release the orange key again to 
return to the default keypad functions.

Numeric/Scroll/Select Numeric, scroll, select keys. Numeric by default.
With the orange key activated, the 2, 4, 6, and 8 keys produce scroll functions and the 5 
key produces a select function. With the FUNC key activated, 7 produces the ESC function 
and 9 produces the TAB function.

Shift Press and release the SHIFT key to activate the keypad alternate SHIFT functions. The 

 icon appears on the taskbar on WinCE devices and the  icon appears at the bottom 
of the screen on Windows Mobile 6.1 device. Press and release the SHIFT key again to 
return to the default keypad functions.

Enter Executes a selected item or function.

BKSP/SPACE BKSP, backspace function by default.
Produces the SPACE function when the blue FUNC key is activated.

Period/Decimal Point Produces a period for alpha entries and a decimal point for numeric entries.

Control Press and release the CTRL key to activate the keypad alternate CTRL functions. The  

icon appears on the taskbar on WinCE devices or the  icon appears at the bottom of 
the screen on Windows Mobile 6.1 devices. Press and release the CTRL key again to 
return to the default keypad functions.
Press and release the blue FUNC key and then the CTRL key to activate the ALT 

functions. The  icon appears on the taskbar on WinCE devices or the  icon appears 
at the bottom of the screen on Windows Mobile 6.1 devices. Press and release the CTRL 
key two times to return to the default keypad functions.

Alpha/Special 
Function

Alpha by default. 
Special function by default when the blue FUNC key is activated.

FUNC (blue) Press and release the blue FUNC function key to activate the keypad alternate functions 
(shown on the keypad in blue). The  icon appears on the taskbar on WinCE devices or 

the  icon appears at the bottom of the screen on Windows Mobile 6.1 devices. Press 
and release the blue FUNC function key again to return to the default keypad functions.

Display Backlight Toggles the display backlight on and off.

Table B-5    48-Key Descriptions (Continued)

Key Description

. . .

ALT ALT

. . .
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Table B-6    48-key Keypad Input Modes

Key Normal Shift + Key Blue + Key

A a A F1

B b B F2

C c C F3

D d D F4

E e E F5

F f F F6

G g G F7

H h H F8

I i I F9

J j J F10

K k K F11

L l L F12

M m M F13

N n N Increase Brightness

O o O

P p P

Q q Q

R r R Increase Volume

S s S Decrease Brightness

T t T

U u T

V v V

W w W Decrease Volume

X x X

Y y Y

Z z Z *

BKSP Backspace Backspace Space

1 1 !

Note: An application can change the key functions. The keypad may not function exactly as described.
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2 2 @

3 3 #

4 4 $

5 5 %

6 6 ^

7 7 &

8 8 *

9 9 (

0 0 )

Table B-6    48-key Keypad Input Modes (Continued)

Key Normal Shift + Key Blue + Key

Note: An application can change the key functions. The keypad may not function exactly as described.
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Appendix C  Windows Mobile 6.5
Introduction
This chapter describes the new features in the latest version of the operating system, OEM version, with Windows 
Mobile 6.5. These include:

• Finger scrolling functionality

• New Home screen

• New Start menu

• New Lock screen

• RS507 support

• Battery Swapping

• USB Configuration.

Finger Scrolling
Windows Mobile 6.5 adds finger scrolling capabilities to the display. Finger scrolling can be used to scroll up and 
down web pages, documents, and lists such as the contacts list, file list, message list, calendar appointments list, 
and more.

When finger scrolling, swipe or flick your finger on the screen.

To scroll down, swipe your finger upward on the screen. To scroll up, swipe your finger downward on the screen.

To auto-scroll, flick your finger upward or downward on the screen. Touch the screen to stop scrolling.

Home Screen
The default home screen on the MC3100 is the Windows Mobile Home screen. The Home screen contains a 
Status Bar at the top of the screen and a Tile Bar at the bottom of the screen.

The Home screen is scrollable and contains a list of application plug-ins and an Information Status bar. The 
Information Status bar highlights the application plug-in that is under it and provides additional information.
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Figure C-1    Windows Mobile Home Screen

Touch and hold the screen with your finger and move the Home screen up and down. As the application names 
move under the Information Status bar, information relevant to that application appear in the bar.

Figure C-2    Moving Home Screen

You can also touch and hold the Information Status bar and move it up and down over an application name. 
Remove your finger and the Information Status bar and application name center in the screen.

Figure C-3    Moving Information Status Bar

Open the Start Menu Tiles

Status Bar

Home Screen

Tile Bar
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Figure C-4    Information Bar Example

To customize the Home screen, tap  > Settings > Home. On the horizontal scroll, use Appearance to customize 
the background and the Items to change the display format.

Classic Today Screen

The user can change to the classic Today screen layout that is used in Windows Mobile 6.1.

Figure C-5    Classic Today Screen

To change to the classic view tap  > Settings > Home > Items.

Figure C-6    Home Screen Settings

Deselect the Windows Default checkbox and select any of the other checkboxes.

Tap .

The task bar at the bottom of the screen can contain the task tray icons listed in Table C-1.

Application Icon

Application Information

Tile Bar

Status Bar

Today Screen

Task Tray
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Status Bar

The Status Bar at the top of the screen displays the status icons listed in Table C-2.

Figure C-7    Status Bar Icons

Table C-1    Task Tray Icons

Icon Name Description

Wireless connection 
status

Wireless connection status icon. Indicates WLAN signal strength and opens the 
Wireless Applications menu.

Bluetooth Enabled The Bluetooth Enabled icon appears in the task tray and indicates that the 
Bluetooth radio is on (Displays only if the StoneStreet One Bluetooth stack is 
enabled).

Bluetooth Disabled The Bluetooth Disabled icon appears in the task tray and indicates that the 
Bluetooth radio is off (Displays only if the StoneStreet One Bluetooth stack is 
enabled).

Bluetooth 
Communication

The Bluetooth Communication icon appears in the task tray and indicates that 
the mobile computer is communicating with another Bluetooth device (Displays 
only if the StoneStreet One Bluetooth stack is enabled).

IST Opens the IST control panel.

ActiveSync The ActiveSync icon appears in the task tray and indicates an active serial 
connection between the mobile computer and the development computer.

Table C-2    Status Bar Icons

Icon Description Icon Description

Notifications

Indicates a reminder of an upcoming calendar 
event.

Notification that one or more instant messages 
were received.

Notification that one or more e-mail/text 
messages were received.

There are more notification icons than can be 
displayed.

Battery
Audio

Connectivity
Notifications

Battery
Clock
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Tap the Status Bar to display an icon bar. Tap an icon to get additional notification or status information.

Figure C-8    Icon Bar

Connectivity

Connection is active. Connection is not active.

Synchronization is occurring. Wi-Fi available.

Wi-Fi in use.

Audio

All sounds are on. All sounds are off.

Vibrate is on.

Battery

Battery is charging. Battery has a full charge.

Battery has a high charge. Battery has a medium charge.

Battery has a low charge. Battery has a very low charge.

Table C-2    Status Bar Icons (Continued)

Icon Description Icon Description

Icon Bar
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Tile Bar

The Tile Bar, located at the bottom of the screen, contains the Start tile  to open the Start Menu. It also 
displays tiles that vary depending upon the open application.

Figure C-9    Tile Bar Examples

Start Screen

To open the Start screen, tap  at the bottom left corner of the screen, or press the START key on the keypad.

Swipe upward to view more program and folder icons.

You can move often-used program and folder icons anywhere on the Start screen for easy access. Press and hold 
the icon that you want to move. Drag the icon to a new location and release.

Table C-4 lists the default icons available on the Start screen.

Table C-3    Icon Bar Icons

Icon Name Description

Magnify Enlarges the screen.

Connectivity Displays the Connectivity dialog box.

Volume Displays the Volume dialog box.

Power Displays the Power window.

Clock & Alarms Opens the Clocks & Alarms window.
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Table C-4    Programs on the Start Screen

Icon Name Description Icon Name Description

ActiveSync Synchronize information 
between the MC3100 and a 
host computer or the 
Exchange Server.

Calendar Keep track of appointments 
and create meeting 
requests.

Contacts Keep track of friends and 
colleagues.

File Explorer Organize and manage files 
on your device.

Messenger Use this mobile version of 
Windows Live Messenger.

Pictures & 
Videos

View and manage pictures, 
animated GIFs, and video 
files.

E-mail Send an Email. Windows 
Media Player 
Mobile

Play back audio and video 
files.

Getting 
Started

Launch the Getting Started 
application.

Marketplace Purchase applications from 
the Marketplace.

Internet 
Explorer 
Mobile

Browse Web and WAP sites 
as well as download new 
programs and files from the 
Internet.

Windows Live Use this mobile version of 
Windows Live™ to find 
information on the web.

Microsoft My 
Phone

Synchronizes the MC3100’s 
contacts, calendar, tasks, 
text messages, music, 
photos videos and 
documents with a Microsoft 
My Phone account.

MSN Money Keep track of your finances.

MSN 
Weather

Check the local weather. Calculator Perform basic arithmetic and 
calculations, such as 
addition, subtraction, 
multiplication, and division.

Games Play games. Text Send an SMS text message.

Notes Create handwritten or typed 
notes, drawings, and voice 
recordings.

Home Displays the Home screen.

Tasks Keep track of your tasks. Settings Opens the Settings folder.
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Internet 
Sharing

Connect a notebook 
computer to the Internet 
using the MC3100's data 
connection.

Help Access on-line Help topics.

Task 
Manager

Enables viewing of memory 
and CPU allocations and 
stops running processes. 
Refer to the Microsoft 
Applications for Windows 
Mobile 6 User Guide for 
more information.

Wireless 
Companion 
Folder

Open the Wireless 
Companion folder.

Search 
Phone

Search contacts, data, and 
other information on the 
MC3100. Refer to the 
Microsoft Applications for 
Windows Mobile 6 User 
Guide for more information.

AirBEAM 
Client

Allows specially designed 
software packages to be 
transferred between a host 
server and the MC3100. 
Refer to the MC3100 
Integrator Guide for more 
information.

BT 
Information

Display information about 
the Bluetooth radio and 
generate a Bluetooth 
address bar code.

Remote 
Desktop 
Mobile

Log onto Windows NT server 
type computers and use all of 
the programs that are 
available on that computer 
from the MC3100.

Modem Link Enables the MC3100 to be 
used as a modem.

Battery Swap

MSP Agent Interacts with MSP agents to 
collect monitoring and asset 
information to enable the 
configuration, provisioning, 
monitoring and 
troubleshooting of the 
MC3100. Refer to the 
MC3100 Integrator Guide for 
more information.

Rapid 
Deployment 
Client

Facilitates software 
downloads from a Mobility 
Services Platform Console 
FTP server to the MC3100. 
Refer to the MC3100 
Integrator Guide for more 
information.

Table C-4    Programs on the Start Screen

Icon Name Description Icon Name Description
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Speaker Icon

You can adjust the system volume using the Speaker icon.

1. Tap the Status Bar and then tap the Speaker icon. The Volume dialog box appears.

Figure C-10    Volume Dialog Box

2. Tap and move the slide bar to adjust the volume.

3. Select the On or Off radio button to turn the volume on or off.

Battery Icons

The Battery icon in the Status Bar indicates the battery power level. To view or change power settings, tap the Status 
Bar. Tap the BAttery icon to display the Power window.

Alarms Set the device clock to the 
date and time of your locale 
or to a visiting time zone 
when you’re traveling. Alarms 
can also be set at specified 
days and times of a week.

Office Mobile Use the suite of Microsoft® 
Office applications for your 
mobile device; Excel Mobile, 
OneNote Mobile, 
PowerPoint Mobile and 
Word Mobile.

BTScannerCtl
Panel

BTExplorer Manages StoneStreet One 
Bluetooth connections.

SwitchUSB

Table C-4    Programs on the Start Screen

Icon Name Description Icon Name Description

NOTE Use can also adjust the system volume using the Sounds & Notifications window or by using the keypad. 
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Figure C-11    Power Window

Connectivity Icon

The Connectivity icon indicates the communication status of the terminal when it’s connecting to the internet or 
host computer. Tap the Status Bar and then tap the Connectivity icon.

Figure C-12    Connectivity Dialog Box

Clock Icon

The Clock icon displays the current time. To change the current time, tap the Status Bar and then tap the Clock 
icon.

Locking the MC3100
You can lock the MC3100 by disabling key presses and screen tap or by requiring a password or finger swipe. 
There are two types of locking features available; the standard Microsoft lock and the Motorola lock.

Microsoft Locking

Locking the MC3100 turns off keyboard and touch screen functionality. This is helpful when the MC3100 is turned 
on and you want to prevent accidental key presses.

To lock the device, tap  > .

The lock screen appears.

NOTE You can make emergency calls even when the MC3100 is locked.
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Figure C-13    Lock Screen

Drag  to either the right or left side of the screen.

If a password is set up, enter the password and then tap  to unlock and display the Home screen, tap  
to unlock and display the Contacts window, tap  to unlock and display the Messaging window.

Figure C-14    Password Window

Password Locking

Use the Password window to set a password to disable unauthorized access to the MC3100.

1. Tap  > Settings > Lock > Password.

Figure C-15    Password Window

2. Select Prompt if device unused for check box to enable password protection.

3. From the drop-down list, select a time value for the protection to take affect after non-use.

NOTE If the device is configured to connect to a network, use a strong (difficult to figure out) password 
to help protect network security. Password cracking tools continue to improve and the 
computers used to crack passwords are more powerful than ever.
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4. From the Password type: drop-down list, select either Simple PIN or Strong alphanumeric.

5. For a simple password, enter a four-digit password in the Password field.

For a stronger password:

a. Enter a seven character password in the Password: field. A strong password must contain at least seven 
characters and contain at least three of the following: uppercase and lowercase letters, numerals, and 
punctuation.

b. Re-enter the password in the Confirm: field.

6. Tap .

7. In the horizontal scroll, select Hint. Enter a hint to remember the password if you forget it.

8. Tap .

9. In the text box, enter a hint for a password reminder.

10. Tap .

When the MC3100 is not used for a period of time and the user tries to access the device, the Lock window 
appears.

Figure C-16    Lock Window

1. Slide the Lock button to the left or right.

2. Enter the password to un-lock the device.

Figure C-17    Enter Password Window

3. Tap the Unlock icon.
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Using the RS507 Hands-free Imager
An RS507 Hands-free Imager can be used with the MC3100 to capture bar code data.

To set up the RS507:

1. Tap Start > Programs > BTScannerCtlPanel icon.

2. If required, select the BT Scanner checkbox and then select the appropriate Com port from the drop-down list.

3. Tap Save and Exit.

4. Tap Start > Programs > BD Address icon. A bar code displays.

5. Point the RS507 to the bar code. The RS507 reads the bar code and begins pairing with the MC55.

Refer to the RS507 Hands-free Imager Product Reference Guide for more information.

Removing the Battery
The OEM version XXXXX provides an application that assists when suspending the MC3100 or when removing the 
battery.

Battery Removal

To remove the battery:

1. If the MC3100 is in suspend mode, press the red Power button to wake the device.

2. Press the red Power button to suspend the MC3100. The Power Key Action screen appears.

Figure C-18    PowerKey Action Window

3. Tap Safe Battery Swap icon.

4. Wait for the red decode LEDs to turn on and then turn off.

5. Remove the battery.

Suspend Mode

To place the MC3100 in suspend mode:

1. Press the red Power button to suspend the MC3100. The Power Key Action screen appears.
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Figure C-19    PowerKey Action Window

2. Tap Suspend icon.

3. The MC3100 goes into suspend mode.

USB Configuration
The MC3100 can be placed into any of the following USB modes:

• USB Client

• USB Host

• USB On-the-Go.

To place the MC3100 into one of these modes:

1. Tap Start > Settings > System > USBConfig.

2. Select on of the radio buttons.

3. Tap .
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Numeric

802.11/802.11abg. A radio protocol that may be used by the WLAN radio card.

A

Access Point. Access Point (AP) refers to Motorola’s Ethernet Access Point. It is a piece of communications equipment that 
manages communications between the host computer system and one or more wireless terminals. An AP connects to 
a wired Ethernet LAN and acts as a bridge between the Ethernet wired network and IEEE 802.11 interoperable 
radio-equipped mobile units, such as a mobile computer. The AP allows a mobile user to roam freely through a facility 
while maintaining a seamless connection to the wired network.

AirBEAM® Manager. AirBEAM® Manager is a comprehensive wireless network management system that provides 
essential functions that are required to configure, monitor, upgrade and troubleshoot the   wireless network and its 
components (including networked mobile computers). Some features include event notification, access point 
configuration, diagnostics, statistical reports, auto-discovery, wireless proxy agents and monitoring of access points and 
mobile units. 

AirBEAM® Smart Client. AirBEAM® Smart Client is part of Motorola’s AirBEAM® suite, which also includes AirBEAM® 
Safe and AirBEAM® Manager. The AirBEAM® Smart Client system uses the network accessible host server to store 
software files that are to be downloaded to the mobile computers. The AirBEAM® Smart Client provides the mobile 
computers with the “smarts” to request software from the host. It allows them to request, download and install software, 
as well as to upload files and status data. The AirBEAM® Smart Client uses the industry standard FTP or TFTP file 
transfer protocols to check the host system for updates, and if necessary, to transfer updated software. Most often, 
AirBEAM® Smart Client is used with wireless networks, but any TCP/IP connection can be used. For more information, 
refer to the AirBEAM® Smart Windows® CE Client Product Reference Guide (p/n 72-63060-xx).

AP. See Access Point.

Aperture. The opening in an optical system defined by a lens or baffle that establishes the field of view.

 ASCII. American Standard Code for Information Interchange. A 7 bit-plus-parity code representing 128 letters, numerals, 
punctuation marks and control characters. It is a standard data transmission code in the U.S.
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B

Bar Code. A pattern of variable-width bars and spaces which represents numeric or alphanumeric data in machine-readable 
form. The general format of a bar code symbol consists of a leading margin, start character, data or message character, 
check character (if any), stop character, and trailing margin. Within this framework, each recognizable symbology uses 
its own unique format. See Symbology.

Bar Code Density. The number of characters represented per unit of measurement (e.g., characters per inch).

Bar Height. The dimension of a bar measured perpendicular to the bar width.

Bar Width. Thickness of a bar measured from the edge closest to the symbol start character to the trailing edge of the same 
bar.

Bit. Binary digit. One bit is the basic unit of binary information. Generally, eight consecutive bits compose one byte of data. 
The pattern of 0 and 1 values within the byte determines its meaning.

Bits per Second (bps). Bits transmitted or received.

bps.  See Bits Per Second.

Byte. On an addressable boundary, eight adjacent binary digits (0 and 1) combined in a pattern to represent a specific 
character or numeric value. Bits are numbered from the right, 0 through 7, with bit 0 the low-order bit. One byte in 
memory is used to store one ASCII character.

boot or boot-up. The process a computer goes through when it starts. During boot-up, the computer can run self-diagnostic 
tests and configure hardware and software.

C

CDRH. Center for Devices and Radiological Health. A federal agency responsible for regulating laser product safety. This 
agency specifies various laser operation classes based on power output during operation.

CDRH Class 1. This is the lowest power CDRH laser classification. This class is considered intrinsically safe, even if all laser 
output were directed into the eye's pupil. There are no special operating procedures for this class.

CDRH Class 2. No additional software mechanisms are needed to conform to this limit. Laser operation in this class poses 
no danger for unintentional direct human exposure.

Character. A pattern of bars and spaces which either directly represents data or indicates a control function, such as a 
number, letter, punctuation mark, or communications control contained in a message.

Character Set. Those characters available for encoding in a particular bar code symbology.

Check Digit. A digit used to verify a correct symbol decode. The scanner inserts the decoded data into an arithmetic formula 
and checks that the resulting number matches the encoded check digit. Check digits are required for UPC but are 
optional for other symbologies. Using check digits decreases the chance of substitution errors when a symbol is 
decoded.
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Codabar. A discrete self-checking code with a character set consisting of digits 0 to 9 and six additional characters: (“-”, “$”, 
“:”, “/”, “,”, and “+”).

Code 128. A high density symbology which allows the controller to encode all 128 ASCII characters without adding extra 
symbol elements.

Code 3 of 9 (Code 39). A versatile and widely used alphanumeric bar code symbology with a set of 43 character types, 
including all uppercase letters, numerals from 0 to 9 and 7 special characters (“-”, “.”, “/”, “+”, “%”, “$” and space). The 
code name is derived from the fact that 3 of 9 elements representing a character are wide, while the remaining 6 are 
narrow.

Code 93. An industrial symbology compatible with Code 39 but offering a full character ASCII set and a higher coding 
density than Code 39.

Cold Boot. A cold boot restarts the mobile computer and erases all user stored records and entries.

COM port.  Communication port; ports are identified by number, e.g., COM1, COM2.

Cradle. A cradle is used for charging the terminal battery and for communicating with a host computer, and provides a 
storage place for the terminal when not in use.

D

Dead Zone. An area within a scanner's field of view, in which specular reflection may prevent a successful decode.

Decode. To recognize a bar code symbology (e.g., UPC/EAN) and then analyze the content of the specific bar code 
scanned.

Decode Algorithm. A decoding scheme that converts pulse widths into data representation of the letters or numbers 
encoded within a bar code symbol.

Decryption. Decryption is the decoding and unscrambling of received encrypted data. Also see, Encryption and Key.

Depth of Field. The range between minimum and maximum distances at which a scanner can read a symbol with a certain 
minimum element width.

Discrete 2 of 5. A binary bar code symbology representing each character by a group of five bars, two of which are wide. 
The location of wide bars in the group determines which character is encoded; spaces are insignificant. Only numeric 
characters (0 to 9) and START/STOP characters may be encoded.

E

EAN. European Article Number. This European/International version of the UPC provides its own coding format and 
symbology standards. Element dimensions are specified metrically. EAN is used primarily in retail.

EMDK. Enterprise Mobility Developer’s Kit.

ESD. Electro-Static Discharge
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ESN. Electronic Serial Number. The unique hardware number associated with a cellular device, which is transmitted to the 
system when the device communicates with the cellular system.

Ethernet. Ethernet communication port. Allows a wired interface to a radio network.

F

Flash Memory. Flash memory is responsible for storing the system firmware and is non-volatile. If the system power is 
interrupted the data is not be lost.

FTP. See File Transfer Protocol.

G

Gateway Address. An IP address for a network gateway or router. A mobile computer may be part of a subnet as specified 
by its IP address and Netmask. It can send packets directly to any node on the same subnet. If the destination node is 
on a different subnet, then the terminal sends the packet to the gateway first. The gateway determines how to route the 
packet to the destination subnet. This field is an option used by networks that require gateways.

H

Hard Reset. See Cold Boot.

Hz. Hertz; A unit of frequency equal to one cycle per second.

Host Computer. A computer that serves other terminals in a network, providing such services as computation, database 
access, supervisory programs and network control.

I

IEC. International Electrotechnical Commission. This international agency regulates laser safety by specifying various laser 
operation classes based on power output during operation.

IEC (825) Class 1. This is the lowest power IEC laser classification. Conformity is ensured through a software restriction of 
120 seconds of laser operation within any 1000 second window and an automatic laser shutdown if the scanner's 
oscillating mirror fails. 

Interleaved 2 of 5. A binary bar code symbology representing character pairs in groups of five bars and five interleaved 
spaces. Interleaving provides for greater information density. The location of wide elements (bar/spaces) within each 
group determines  which  characters  are encoded. This continuous code type uses no intercharacter spaces. Only 
numeric (0 to 9) and START/STOP characters may be encoded.
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imaging scanning . Mobile computers with an integrated imager use digital camera technology to take a digital picture of 
a bar code, store the resulting image in memory and execute state-of-the-art software decoding algorithms to extract 
the data from the image.

Intercharacter Gap.  The space between two adjacent bar code characters in a discrete code.

Interleaved Bar Code. A bar code in which characters are paired together, using bars to represent the first character and 
the intervening spaces to represent the second.

Interleaved 2 of 5. A binary bar code symbology representing character pairs in groups of five bars and five interleaved 
spaces. Interleaving provides for greater information density. The location of wide elements (bar/spaces) within each 
group determines which characters are encoded. This continuous code type uses no intercharacter spaces. Only 
numeric (0 to 9) and START/STOP characters may be encoded.

IP. Internet Protocol. The IP part of the TCP/IP communications protocol. IP implements the network layer (layer 3) of the 
protocol, which contains a network address and is used to route a message to a different network or subnetwork. IP 
accepts “packets” from the layer 4 transport protocol (TCP or UDP), adds its own header to it and delivers a “datagram” 
to the layer 2 data link protocol. It may also break the packet into fragments to support the maximum transmission unit 
(MTU) of the network.

IP Address. (Internet Protocol address) The address of a computer attached to an IP network. Every client and server 
station must have a unique IP address. A 32-bit address used by a computer on a IP network. Client workstations have 
either a permanent address or one that is dynamically assigned to them each session. IP addresses are written as four 
sets of numbers separated by periods; for example, 204.171.64.2.

L

LAN. Local area network. A radio network that supports data communication within a local area, such as within a warehouse 
of building.

laser scanner. A type of bar code reader that uses a beam of laser light.

LASER.  Light Amplification by Stimulated Emission of Radiation.The laser is an intense light source. Light from a laser is 
all the same frequency, unlike the output of an incandescent bulb. Laser light is typically coherent and has a high energy 
density.

Laser Diode. A gallium-arsenide semiconductor type of laser connected to a power source to generate a laser beam. This 
laser type is a compact source of coherent light.

LED Indicator. A semiconductor diode (LED - Light Emitting Diode) used as an indicator, often in digital displays. The 
semiconductor uses applied voltage to produce light of a certain frequency determined by the semiconductor's particular 
chemical composition.

M

MC. Mobile Computer.

MIL. 1 mil = 1 thousandth of an inch.
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MIN. Mobile Identification Number. The unique account number associated with a cellular device. It is broadcast by the 
cellular device when accessing the cellular system.

Mobile Computer. In this text, mobile computer refers to the Motorola handheld computer. It can be set up to run as a 
stand-alone device, or it can be set up to communicate with a network, using wireless radio technology.

N

Nominal. The exact (or ideal) intended value for a specified parameter. Tolerances are specified as positive and negative 
deviations from this value.

Nominal Size. Standard size for a bar code symbol. Most UPC/EAN codes are used over a range of magnifications (e.g., 
from 0.80 to 2.00 of nominal).

P

Parameter. A variable that can have different values assigned to it.

Percent Decode. The average probability that a single scan of a bar code would result in a successful decode. In a 
well-designed bar code scanning system, that probability should approach near 100%.

Q

Quiet Zone. A clear space, containing no dark marks, which precedes the start character of a bar code symbol and follows 
the stop character.

R

RAM. Random Access Memory. Data in RAM can be accessed in random order, and quickly written and read.

Reflectance. Amount of light returned from an illuminated surface.

Resolution. The narrowest element dimension which is distinguished by a particular reading device or printed with a 
particular device or method.

RF. Radio Frequency.

ROM. Read-Only Memory. Data stored in ROM cannot be changed or removed.

Router. A device that connects networks and supports the required protocols for packet filtering. Routers are typically used 
to extend the range of cabling and to organize the topology of a network into subnets. See Subnet.
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RS232. An Electronic Industries Association (EIA) standard that defines the connector, connector pins, and signals used to 
transfer data serially from one device to another.

S

Scan Area. Area intended to contain a symbol.

Scanner. An electronic device used to scan bar code symbols and produce a digitized pattern that corresponds to the bars 
and spaces of the symbol. Its three main components are:

1. Light source (laser or photoelectric cell) - illuminates a bar code.

2. Photodetector - registers the difference in reflected light (more light reflected from spaces).

3. Signal conditioning circuit - transforms optical detector output into a digitized bar pattern.

Scanning Mode. The scanner is energized, programmed and ready to read a bar code.

Scanning Sequence. A method of programming or configuring parameters for a bar code reading system by scanning bar 
code menus.

SDK. Software Development Kit

Shared Key. Shared Key authentication is an algorithm where both the AP and the MU share an authentication key.

SID. System Identification code. An identifier issued by the FCC for each market. It is also broadcast by the cellular carriers 
to allow cellular devices to distinguish between the home and roaming service.

Soft Reset. See Warm Boot.

Space. The lighter element of a bar code formed by the background between bars.

Specular Reflection. The mirror-like direct reflection of light from a surface, which can cause difficulty decoding a bar code.

Start/Stop Character. A pattern of bars and spaces that provides the scanner with start and stop reading instructions and 
scanning direction. The start and stop characters are normally to the left and right margins of a horizontal code.

Subnet. A subset of nodes on a network that are serviced by the same router. See Router.

Subnet Mask. A 32-bit number used to separate the network and host sections of an IP address. A custom subnet mask 
subdivides an IP network into smaller subsections. The mask is a binary pattern that is matched up with the IP address 
to turn part of the host ID address field into a field for subnets. Default is often 255.255.255.0.

Substrate. A foundation material on which a substance or image is placed.

Symbol. A scannable unit that encodes data within the conventions of a certain symbology, usually including start/stop 
characters, quiet zones, data characters and check characters.

Symbol Aspect Ratio. The ratio of symbol height to symbol width.

Symbol Height. The distance between the outside edges of the quiet zones of the first row and the last row.
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Symbol Length. Length of symbol measured from the beginning of the quiet zone (margin) adjacent to the start character 
to the end of the quiet zone (margin) adjacent to a stop character.

Symbology. The structural rules and conventions for representing data within a particular bar code type (e.g. UPC/EAN, 
Code 39, PDF417, etc.).

T

Tolerance. Allowable deviation from the nominal bar or space width.

U

UPC. Universal Product Code. A relatively complex numeric symbology. Each character consists of two bars and two 
spaces, each of which is any of four widths. The standard symbology for retail food packages in the United States.

V

Visible Laser Diode (VLD). A solid state device which produces visible laser light.

W

WAN. Wide-Area Network. A radio network that supports data communication beyond a local area. That is, information can 
be sent across a city, state, or even nationwide.

Warm Boot. A warm boot restarts the mobile computer by closing all running programs. All data that is not saved to flash 
memory is lost.

Wireless Local Area Network (WLAN). See LAN.
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